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操作上の予防措置および制限事項 1
注: システムを操作する前に、本ガイドのすべてのセクションを注意してお読みください。

本項には、一般の安全関連の情報が含まれており、規制対応の情報が提供されています。また、
システムに関する潜在的な危険および関連する警告および危険を最小限にするために採るべき予
防措置も説明されています。

ラボ環境、システムおよび本文書内で使用されている記号に関する情報については、本項に加え
て、シンボルについての用語集を参照してください。施設要求事項については、設置計画概要書を
参照してください。

一般的な安全情報
人身傷害またはシステムの損傷を防ぐために、本書、メーカーの化学薬品安全性データシート
（SDS）、および製品ラベル情報に記載されているすべての安全に関する注意事項および警告を読
み、理解し、それに従ってください。ラベルは、国際的に認められたシンボルで表示されています。こ
れらの警告に従わない場合、重傷に至る可能性があります。

この安全情報は、連邦、州、地方、および地域環境、衛生および安全 （EHS） 規制を補足するもの
です。実践すべき安全手順がすべて掲載されているわけではありません。最終的に、連邦、州、地
方、そして地域の EHS 規則等の遵守、および安全なラボ環境の維持に対する責任は、ユーザーと
組織にあります。

適切なラボの参考資料と標準作業手順書を参照してください。

文書内の記号と規約
このガイド内では以下のシンボルと規約が適用されます。

危険! 「危険」は致命傷や死を引き起こす行動を指します。

警告! 「警告」は、注意点を守らなかった場合に人身傷害を引き起こす可能性のある行動を
指します。

注意: 「注意」は注意点を守らなかった場合にシステム損傷やデータ損失を引き起こす可能性のあ
る行動を指します。

注: 「注」は手順および説明内の重要な情報を指します。

ヒント! 「ヒント」は本文記載の技術および手順の応用に役立つ情報です。特別なニーズがある場
合、手順を短縮する場合の補足事項として使用ください。手順を完了するために必須のものではあ
りません。

操作上の予防措置および制限事項
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監督法規の遵守
本システムは、本セクションに記載されている規制および標準に準拠しています。引用規格は、シス
テムおよび個々のシステムコンポーネント同梱の適合宣言書を参照してください。適応ラベルはシ
ステムに貼られています。

オーストラリアおよびニュージーランド

• 電磁両立性 （EMC）：1992 年無線通信法に以下の標準として制定：

• 電波障害 —AS/NZS CISPR 11/ EN 55011/ CISPR 11 (Class A)。電磁妨害を参照してくだ
さい。

カナダ

• 電磁妨害（EMI）： CAN/CSA CISPR11。この ISM 機器は、カナダ ICES-001 に適合していま
す。次のセクションを参照してください：電磁妨害。

• 安全性：

• CAN/CSA C22.2 No.61010-1

欧州

• 電磁両立性 （EMC）：以下の標準で実行されている電磁両立性指令 2014/30/EU：

• EN 61326-1

• EN 55011（Class A）

電磁両立性を参照してください。

• 安全: 以下の標準で実行されている機械指令 2006/42/EC:

• EN 61010-1

• 廃棄物、電気および電子機器（WEEE）：廃電気電子機器指令 2012/96/EEC（EN 40519 で実
施される通り）。廃電気電子機器指令を参照してください。

• 梱包および梱包廃棄物（PPW）：梱包および梱包廃棄物指令 94/62/EC

• RoHS 有害物質制限指令： RoHS 指令 2011/65/EU および 2015/863/EU

米国

• 無線送信妨害規制： 47 CFR 15（FCC Part15 で実施される通り（クラス A））

• 安全性： 職業安全衛生法、29 CFR 1910（以下の標準で実施される通り）：

• UL 61010-1

国際

• 電磁両立性（EMC）：

• IEC 61326-1

操作上の予防措置および制限事項
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• IEC CISPR 11（クラス A）

次のセクションを参照してください：電磁両立性。

• 安全性：

• IEC 61010-1

電気系統に関する注意

警告! 感電の危険。カバーを取り外さないでください。カバーを取り外すと、傷害または
システムの故障が発生する場合があります。定期的なメンテナンス、点検、または調整
のためにカバーを取り外す必要はありません。カバーを取り外す必要がある修理につい
ては、SCIEX フィールドサービスエンジニア（FSE）にお問い合わせください。

• 電気安全作業習慣に従ってください。

• ケーブルの管理慣行の実行により、ケーブルを管理してください。これにより、つまずく危険が軽
減します。

システムの電気仕様については、設置計画概要書を参照してください。

装置主電源

本ガイドの指示の通り、システムを互換性のある主電源に接続します。

警告! 感電の危険。すべての電気機器および接続器の設置は必ず有資格者が実施
し、すべての設置が現地規制および安全規格に従うようにしてください。

警告! 感電の危険。システムに同梱された主電源ケーブルのみを使用します。このシ
ステムの操作にとって適切な定格ではない主電源ケーブルは使用しないでください。

警告! 感電の危険。システムの背面にある主電源インレットから電源ケーブルを外し
て、緊急時にシステムを主電源から切断できることを確認してください。システムの背
面には物を置かないでください。

保護接地線

装置主電源には、保護接地（アース）が正常に組み込まれていなければいけません。システムを接
続する前に、資格のある技師により必ず保護接地線（アース）を設置または点検してください。

警告! 感電の危険。保護接地線を意図的に妨害しないでください。保護接地線の妨
害が生じると、感電の危険が発生します。

操作上の予防措置および制限事項
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化学物質に関する注意

警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。クリ
ーニングまたはメンテナンスを行う前に、汚染除去が必要か判断してください。放射性
物質、生物学的病原体、または有害化学物質が質量分析装置に使用された場合、お
客様はクリーニングまたはメンテナンス前にシステムに対して汚染除去を行う必要があ
ります。

警告! 環境の危険。システムコンポーネントを一般廃棄物として処分しないでください。
コンポーネントを処分する際は、現地規制に従います。

• サービスや定期メンテナンスの前に、システムに使用された化学物質を特定してください。化学
物質について遵守すべき健康および安全上の注意事項については、安全データシート (SDS)
を参照してください。保管情報については、分析証明書を参照してください。SCIEX 安全性デー
タシートまたは分析証明書を見つけるには、sciex.com/tech-regulatory にアクセスしてくださ
い。

• 割り当てられた個人用保護具を常に着用してください。これにはパウダーフリーの手袋、安全メ
ガネ、および白衣が含まれます。

注: ニトリルまたはネオプレンの手袋をお勧めします。

• 通気性の良いエリアまたは換気フード内で作業を行ってください。

• イソプロパノール、メタノール、その他可燃性溶媒などの可燃性物質を用いて作業を行う際に
は、発火源を避けてください。

• 化学物質の使用および廃棄については十分注意してください。化学物質の取り扱いおよび廃棄
について正しい手順が守られない場合には、人身傷害の危険があります。

• クリーニングの間、および使用後の手洗いの際には化学物質が肌に触れないようにしてくださ
い。

• 使用済み液体をすべて回収し、有害廃棄物として処分します。

• 生物学的危険のある物質、毒性物質、および放射性物質の保管、取り扱い、廃棄については、
すべての現地規制を遵守してください。

システムに対して安全な液体

注意: システムに損傷を与える恐れ。他の液体は、SCIEX によって危険がないことが確認されるま
で、使用しないでください。これは完全なリストではありません。

注意: システムに損傷を与える恐れ。キャピラリーウィンドウのクリーニングに、メタノール、アセトン
などの有機溶剤を使用しないでください。有機溶剤は接着剤を溶かしてしまい、キャピラリーウィンド
ウに残留物が残り、検出器に干渉する可能性があります。

BioPhase 8800 分析キットに含まれている物質、または BioPhase 8800 System アプリケーション
ガイドで参照されている物質は、このシステムで安全に使用することができます。また、以下の液体

操作上の予防措置および制限事項
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も、本システムで安全に使用できます。他の化学物質への適合性については、sciex.com/request-
support にお問い合わせください。

• 酸と塩基

pH 範囲は 2～12 です。

• 酢酸、最大　10%

• 水酸化ナトリウム、最大 1 M

• 塩酸、最大 1 M

• 試薬

• CE Grade Water

物理的な注意事項

警告! 持ち上げ時の危険。 システムを持ち上げたり移動したりする際は、機械式昇降装置
を使用します。 システムを手動で移動しなければならない場合、システムを安全に動かす
には少なくとも 4 人が必要です。 認定を受けた安全な持ち上げ手順に従います。専門の移
動サービス業者に依頼することを推奨します。

環境に関する注意事項
送電線、加熱装置、換気装置、配管の供給および固定などのインストールについては資格のある
担当者にお問い合わせください。すべての設置が地方条例および有害物質規制を遵守していること
を確認してください。システムの環境条件への要求事項に関する情報は、設置計画概要書を参照し
てください。

システムのセットアップを行う際には、機器の周囲にアクセス空間を確保してください。

警告! 生物学的危険。生物学的危険のある物質を使用する場合、危険性評価、制御、およ
び危険物取り扱いに関する現地規制を必ず遵守します。本システム、あるいはそのいかな
る部分も、生物学的封じ込めとして機能することを意図していません。

警告! 環境の危険性。生物学的危険、有毒性、放射性がある廃棄物、および電子廃棄
物の処分に関しては確立された手順に従ってください。化学物質、廃油および電子部品
を含む危険物質の廃棄については、お客様が地域の法律および規制に従って行う責任
があります。

電磁環境
電磁両立性

基本的電磁環境：公共メインネットワークからの低電圧で直接供給されているという特徴がある場
所に存在する環境。

機器は、基本的電磁環境での使用を前提としています。

操作上の予防措置および制限事項
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装置と互換性のある電磁環境が整備されており、装置が想定どおりに操作できることを確認してく
ださい。電源ラインの電気的ノイズが大きい場合は、サージ保護装置を取り付けてください。

電磁妨害

グループ 1 機器： この機器は、内部動作に RF エネルギーを使用する可能性のある産業・科学・医
療（ISM）用機器に分類されます。

クラス A 機器：家庭用施設および住宅用に使用される建物に供給する低電圧電源供給ネットワー
クに直接接続する施設以外のすべての施設内での使用に適する機器。[CISPR 11:2009, 5.3 より
派生] クラス A 機器はクラス A の制限を満たすものとします。

注意: 電波障害の恐れ。この機器は住宅環境での使用を意図したものではなく、そのような環境で
は無線受信に対する適切な保護が得られない恐れがあります。

この装置はクラス A デジタル機器の制限に準拠したテストを行っており、FCC（Federal
Communications Commission：連邦通信委員会）コンプライアンス規制パート 15 の基準を満たし
ています。

これらの制限は、装置が商業環境下で用いられた場合に、妨害行為から装置を適切に保護する必
要性を考慮したものです。この装置は高周波エネルギーの生成、使用および放出を行います。オペ
レーターズマニュアルに従ってインストールおよび使用が行われなかった場合は、ラジオ通信に障
害を発生させる恐れがあります。

住宅地域でのこの装置の操作は、発生した場合に自己負担で妨害を修正する必要がある有害な
妨害を引き起こす恐れがあります。製造業者によって認可のない変更や調節を行った場合、装置を
使用する権限が無効になる場合があります。

停止および廃棄

警告! 環境の危険性。生物学的危険、有毒性、放射性がある廃棄物、および電子廃棄
物の処分に関しては確立された手順に従ってください。化学物質、廃油および電子部品
を含む危険物質の廃棄については、お客様が地域の法律および規制に従って行う責任
があります。

停止の前に、現地規制に従ってシステム全体に対して汚染除去を行います。

システムをサービスから外す際は、国または地域の換気用規制に従って、異なる素材を分別および
リサイクルしてください。

注: SCIEX は汚染除去フォームの記入のない場合、システムの引き取りはお受けしかねます。フォ
ームのコピーが必要な場合は、フィールドサービスエンジニア（FSE）にお問い合わせください。

分別していない一般廃棄物としてコンピュータの部品を含むシステムのコンポーネントおよびサブア
センブリを廃棄しないでください。

廃電気電子機器指令

廃棄物、電気および電子機器（WEEE）の環境への影響を軽減するための適切な廃棄規定につい
ては、地域の一般廃棄物命令に従ってください。この機器を安全に廃棄するために、お近くのカスタ
マーサービスに連絡し、無料の機器引き取りおよびリサイクルをご利用ください。

操作上の予防措置および制限事項
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紫外線に関する注意事項

警告! 紫外線障害の危険。直接的な紫外線または反射した紫外線を浴びないようにしてく
ださい。紫外線は目や皮膚に有害です。必要なシステム安全インターロックがない状態で
UV 光源を操作しないでください。

レーザーに関する注意事項
このセクションは、レーザー誘起蛍光（LIF）検出システムを搭載したシステムに適用されます。

警告! レーザーの危険性。レーザーの安全性に適用される、地域のすべての規則、規制、
標準、および社内の要件に従います。

警告! レーザーの危険性。このガイドに記載されている方法とは異なる方法で装置や制御を
使用したり、手順を実行したりしないでください。有害なレーザー照射被曝の原因となること
があります。

警告! 人身傷害の危険。レーザービームの予想経路やレーザー光線の鏡面反射を直視し
ないでください。レーザーからの目に見えない紫外線は、目に損傷を与える可能性がありま
す。

警告! 人身傷害の危険。レーザーアセンブリの外側のカバーを取り外さないでください。カバ
ーがない場合は、潜在的に有害なレーザー放射にさらされる可能性があります。

LIF 検出システムには、密閉されたモジュールにクラス I のレーザーシステムが含まれています。こ
のモジュールには、クラス 3B のレーザーコンポーネントが組み込まれています。3B の分類は、こ
のタイプのレーザーのビーム内を直接見ることが、作業者にとって常に危険であることを意味しま
す。

レーザーアセンブリでは、レーザーと他のいくつかのコンポーネントが密閉されたハウジングに格納
されており、ユーザーが保守できる部品はありません。レーザーアセンブリの保守は、資格を持つ
SCIEX フィールドサービスエンジニア（FSE）に限定されています。そのため、システム全体のレー
ザー分類は、合理的に予見可能な動作条件下で安全なレーザーと定義されるクラス 1 となってい
ます。

資格のある技術者
資格のある SCIEX エンジニアのみが、機器の設置、検査、およびサービスを行うようにしてくださ
い。システムのインストール後、フィールドサービスエンジニア（FSE）は設置適格性を使用し、お客
様にシステムの動作、クリーニング、基本のメンテナンスを説明します。SCIEX の承認を受けてい
ない技術者が修理を行った場合、SCIEX による保証の対象外となることがあります。

検査室条件

安全な環境条件

システムは次の条件下で安全に動作するように設計されています。

操作上の予防措置および制限事項
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• 室内

• 高度: 海抜 2,000 m（6,560 フィート）以下

• 周辺温度: 15 °C（59 °F） ~ 40 °C（104 °F）

• 相対湿度：20 % ~ 80 %、結露なし。

• 装置主電源電圧変動：通常電圧の ± 10%

• 過渡過電圧: 過電圧カテゴリ II レベルまで

• 装置主電源の一時的過電圧

• 汚染度 2

パフォーマンス仕様

システムは次の条件下で仕様に適合するように設計されています。

• 設置環境温度 15 °C ～ 30 °C（59 °F ～ 86 °F）

温度は常に、4 °C （7.2 °F）の範囲を維持し、毎時間 2 °C （3.6 °F）以上の変化がないようにし
ます。この制限を超えて環境温度が変化すると、移動時間のシフトが生じる恐れがあります。

• 相対湿度 30 ～ 70%、結露なし。

機器の使用と変更

警告! 感電の危険。カバーを取り外さないでください。カバーを取り外すと、傷害または
システムの故障が発生する場合があります。定期的なメンテナンス、点検、または調整
のためにカバーを取り外す必要はありません。カバーを取り外す必要がある修理につい
ては、SCIEX フィールドサービスエンジニア（FSE）にお問い合わせください。

警告! 人身傷害の危険。SCIEX が推奨する部品のみを使用してください。SCIEX が推奨し
ない部品を使用したり、用途以外の目的で部品を使用すると、測定者が危険にさらされた
り、システムのパフォーマンスに悪影響を及ぼしたりする可能性があります。

警告! 持ち上げ時の危険。 システムを持ち上げたり移動したりする際は、機械式昇降装置
を使用します。 システムを手動で移動しなければならない場合、システムを安全に動かす
には少なくとも 4 人が必要です。 認定を受けた安全な持ち上げ手順に従います。専門の移
動サービス業者に依頼することを推奨します。

システムは、質量分析装置の設置計画概要書で推奨されている環境条件下にある屋内のラボで使
用するか、または FSE に連絡してください。

システムを製造業者の規定に反した環境および方法で使用した場合、機器に備わっている性能や
保護機能が損なわれる可能性があります。

システムサービスに関する情報は、FSE にお問い合わせください。 システム上で認定外の変更や
動作を行ったために人身傷害や機器の破損が発生した場合は、保障が適用されない可能性があり
ます。 システムが推奨環境条件の範囲外で使用された場合、および認定外の変更を行った場合の
どちらであっても、正常でないデータが生成されることがあります。

操作上の予防措置および制限事項
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はじめに 2
このガイドでは、BioPhase 8800 システムの基本操作、トラブルシューティング、およびメンテナンス
について説明しています。本製品を使用する前に本ガイドをよくお読みになり、ガイドの指示に従っ
て操作してください。

このガイドでは、安全に操作していただくために、安全に関する注意事項を記載しています。ガイド
に記載されているすべての警告および注意事項に従ってください。

説明
BioPhase 8800 システムは 8 チャンネルのキャピラリー電気泳動システムで、ユーザーの介入なし
に最大 96 サンプルの分離を実行できます。

BioPhase 8800 システムには、以下のコンポーネントが含まれています。

• 前面パネルに搭載されたタッチスクリーン

• UV 光源と検出器

• （オプション）488 nm レーザーおよび LIF 検出システム

• システムを制御し、データ収集を行うためのソフトウェア。次のいずれかです。

• BioPhase ソフトウェア。データ分析用アプリケーション BioPhase Analysis ソフトウェアは、
BioPhase ソフトウェア、

• BioPhase 8800 driver for Empower™ に含まれています。BioPhase 8800 driver for
Empower™ で収集されたデータのデータ分析は、BioPhase Analysis ソフトウェアでは分析
できません。

このシステムでは、8 本のベアフューズドシリカ、または 8 本のニュートラルキャピラリーが入った組
み立て済みのカートリッジを使用します。

SCIEX では、BioPhase 8800 システムで使用できるように設計された分析キットを提供していま
す。キットには試薬およびサンプルと試薬のプレートが含まれています。

関連ドキュメント
このドキュメントは、Waters Empower™ソフトウェアについてある程度の知識があることを前提とし
ています。 Waters Empower™ソフトウェアの一般的な機能については、以下をご覧ください。

• ソフトウェアに付属のドキュメントを参照。

• Empower の起動ダイアログの をクリック

• Help のクリックは、Waters Empower™ソフトウェア ウィンドウのいずれかで行います。

特定のキャピラリー電気泳動アプリケーションに対する Waters Empower™ソフトウェアの使用方法
の詳細については、次のアプリケーション ガイドを参照してください。

• Capillary Isoelectric Focusing (cIEF) Analysis Application Guide

はじめに
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• CE-SDS タンパク質キットアプリケーションガイド

• RNA 9000 Purity & Integrity キットアプリケーション ガイド

Waters Empower™ Software 用語
（BioPhaseSoftware ユーザー用）
BioPhase ソフトウェアで BioPhase 8800 システムを使用したことがあるユーザーは、Waters
Empower™ソフトウェアの用語に精通している必要があります。

表 2-1 : Waters Empower™ Software 用語（BioPhaseSoftware ユーザー用）

BioPhase ソフトウェアの
用語

Waters Empower™ソフト
ウェア対応

説明

BioPhase ソフトウェアに
相当するものがない

装置メソッド データ取得に必要なシステムパラメータ
を含むメソッド。パラメータは、全般パラメ
ータ、検出器パラメータ、および時間プロ
グラムとしてグループ化されています。

処理メソッド データ処理パラメータを含むメソッド。

レポートメソッド 処理メソッドの結果を示すレポートを作
成するメソッド。

メソッド メソッドセット 装置メソッド、処理メソッド、およびレポー
トメソッドの組み合わせ。処理メソッドとレ
ポートメソッドはオプションです。

シーケンス サンプルセットメソッド データ取得のために BioPhase 8800 シ
ステムに送信されるサンプルと関連する
メソッドセットのリスト。オプションで、
Waters Empower™ソフトウェアは取得
後のデータ処理を実行し、レポートを生
成できます。

レポート レポート データ取得の結果に関する情報を含む
ファイル。レポートには、データを生成す
る組織に関する情報を含めることもでき
ます。レポートのレイアウトと外観はカス
タマイズして、レポートテンプレートの一
部として保存できます。

サンプルインレットプレート プレート 分析するサンプルを保持する 96 ウェル
プレート。

サンプルアウトレットプレ
ート

プレート 分離に必要なゲルまたは緩衝液を含む
8 つのトラフ付きプレート。

試薬インレットプレート プレート 試薬とすすぎ液を保持する 96 ウェルプ
レート。

試薬アウトレットプレート プレート キャピラリー廃棄物を収集する 8 つのト
ラフ付きプレート。

はじめに
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表 2-1 : Waters Empower™ Software 用語（BioPhaseSoftware ユーザー用） (続き)

BioPhase ソフトウェアの
用語

Waters Empower™ソフト
ウェア対応

説明

コンピュータ LAC/E モジュール BioPhase 8800 システムを制御するコン
ピュータ。

ハードウェアの概観

図 2-1 : プレートコンパートメントを開けた状態の前面および側面パネル

項目 説明

1 フロントパネル

2 電源ボタン

3 ドアを開けた状態のプレートコンパートメント

4 光学ドア

はじめに
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図 2-2 : 背面パネル

項目 説明

1 装置主電源接続部とヒューズホルダー

2 RJ-45 ネットワークコネクタ

はじめに
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カートリッジ

図 2-3 : カートリッジ前面

項目 説明

1 ハンドル

2 シリアル番号ラベル

3 キャピラリーのインレット

4 キャピラリーのアウトレット

5 電極

6 キャピラリーウィンドウとアパチャ（開口部）

はじめに
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図 2-4 : カートリッジ背面

項目 説明

1 キャピラリーウィンドウとアパチャ（開口部）

2 圧力アウトレットポート

3 クーラントアウトレットポート

4 電極

5 キャピラリーのアウトレット

6 クーラントインレットポート

7 キャピラリーのインレット（左からキャピラリー A ～ H）

8 圧力インレットポート

9 ID チップ

10 ハンドル

利用可能なカートリッジ

BioPhase 8800 カートリッジには、以下の構成で 8 本のキャピラリーが用意されています。

• 内径 50 µm × 30 cm ベアフューズドシリカキャピラリー

• 内径 50 µm × 30 cm ニュートラルキャピラリー

はじめに
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サンプルプレート

BioPhase 8800 システムは、96 ウェルサンプルプレートを使用しています。

自動液体処理システムで使用するプレートの構成は、プレートの仕様を参照してください。

図 2-5 : サンプルプレート

項目 説明

1 アライメントノッチ

2 面取りされた隅

試薬プレート

自動液体処理システムで使用するプレートの構成は、プレートの仕様を参照してください。

はじめに
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図 2-6 : 試薬プレート

項目 説明

1 アライメントノッチ

2 面取りされた隅

アウトレットプレート

自動液体処理システムで使用するプレートの構成は、プレートの仕様を参照してください。

図 2-7 : アウトレットプレート

項目 説明

1 試薬ウェル

2 オーバーフローウェル、空のままにする

はじめに
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項目 説明

3 面取りされた隅

動作原理
キャピラリー電気泳動（CE）は、サンプルの成分を分離し、定量する技術です。CE メソッドでは、電
解質溶液中を電界の影響を受けながら分析試料が移動します。非共有結合性相互作用による移
動度や相間への分配によって、分析試料を分離することができます。さらに、導電性や pH の勾配
を利用して、分析試料を濃縮したり、フォーカスしたりすることも可能です。

BioPhase 8800 システムでのデータ取得は、Waters Empower™ソフトウェアと組み合わせて
BioPhase 8800 driver for Empower™ を使用すると有効になります。Method Editors for
BioPhase System ソフトウェアは BioPhase 8800 driver for Empower™ の一部であり、装置およ
びサンプル セットメソッドの開発に使用されます。

UV 検出システム

UV 検出システムは、紫外線光源、波長フィルター、フォトダイオード検出器を備えています。

UV 光源は重水素ランプで、波長範囲は 190 nm ～ 400 nm です。2 枚のレンズでランプの出力を
集光し、波長選択フィルターの 1 枚に導きます。ビームはカートリッジ内のアパチャ（開口部）を通
り、検出ウィンドウを通過していきます。検出ウィンドウは、ポリイミドコーティングを除去する処理を
施したキャピラリーのセクションです。透過ビームはフォトダイオードまで続きます。光信号は電気信
号に変換されてデジタル化され、ソフトウェアに送られて処理されます。

フィルターホルダーには、フィルター 2 枚分のスペースがあります。BioPhase 8800 システムには、
220 nm と 280 nm の 2 つの 25 nm 帯域幅フィルターが同梱されています。

レーザー誘導蛍光（LIF）検出システム

LIF 検出システムは、オプションのコンポーネントです。

LIF 検出システムには、ソリッドステートの 488 nm レーザー光源を使用しています。励起光は、レ
ーザーからカートリッジ内のキャピラリーに伝達されます。レーザーの波長で蛍光を発するキャピラ
リー内の物質が検出されます。LIF 検出器はこの蛍光を測定・記録し、エレクトロフェログラムにピ
ークとして表示します。装置には 520 nm 発光フィルターが付属しています。

BioPhase 8800 システムと Waters Empower™ ソフトウェア間の
相互作用

BioPhase 8800 システムは、8 本のキャピラリーを備えたカートリッジを使用します。分離は 8 本の
キャピラリーすべてで同時に起こります

分離を実行し、分離データを保存するには、Waters Empower™ソフトウェアは BioPhase 8800
driver for Empower™ を使用します。実行が開始されると、ドライバーは Empower の機能を使って
8 本すべてのキャピラリーの分離を開始します。その後、BioPhase 8800 システムが分離を行いま
す。8 本のキャピラリーの進捗状況と収集されたデータは、Waters Empower™ ソフトウェアの
Trace View ウィンドウで確認できます。

はじめに
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8 本すべてのキャピラリからのデータは、Waters Empower™ソフトウェア取得サーバー上のドライ
バーに送信されます。ドライバーは、一度に 1 本のキャピラリーからデータを保存するか、新しい実
行を開始します。次のセクションを参照：新たな実行の原因。要約すると、分離は同時に行われます
が、データは一度に 1 本のキャピラリーごとに Empower データベースに保存されます。

この手順は、一般的に液体クロマトグラフィーのように、注入開始と同時に Empower データベース
へのデータ保存が開始される Waters Empower™ ソフトウェアでの単一サンプル注入とは異なりま
す。

データの保存にかかる時間は、Waters Empower™ソフトウェアの処理速度とネットワーク速度によ
って決まります。低速なネットワークでは、分離が終了してからデータが Empower データベースに
保存されるまでに時間がかかることがあります。Waters Empower™ソフトウェア Project ウィンドウ
の Injections、Channels、Results、およびその他のタブでは、Date Acquired フィールドにデータ
が保存された時間が表示されます。その結果、同じ時刻にデータを取得していても、Date Acquired
フィールドの値が異なります。これは、Waters Empower™ソフトウェアの Date Acquired フィールド
の設計と機能と一致しています。

分離の終了からデータが保存されるまでの間隔は、ユーザーが実行を停止したときに影響します。
次のセクションを参照：実行の停止。

実行の停止

サンプルセットメソッドが実行中で、システムがビジー状態にある場合、BioPhase 8800 driver for
Empower™ Direct Control ペインに対して許可されません。BioPhase 8800 driver for Empower™

用であり、データを保存中でシステムがアイドル状態にある場合は、ダイレクトコントロールアクショ
ンを使用できますが、使用しないでください。

注意: データ損失の可能性。Empower 用の BioPhase 8800 driver for Empower™ システムス
テータスがアイドル状態であっても、実行中の Direct Control ペイン。いかなるアクションもデータ
の取得を妨げる可能性があります。

実行を終了する前に停止する必要がある場合、データベースに保存されるデータには、赤いテキス
トの 2 行目から最後の行までのサンプルのみが含まれます。現在の行（赤いテキスト）のすべての
データは保存されません。必要なデータがすべて保存されていることを確認するには、次のいずれ
かを行います。

• サンプルセットメソッドを完了させます。メソッドが完了すると、Abort ボタン（ ）が赤から緑

（ ）に変わります。

• 必要なサンプルのデータが保存され、次の注入が開始されるまで待ってから、実行を停止しま
す。

システムをオンにしてログオン
1. システム前面の電源ボタンを押します。

はじめに
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図 2-8 : 装置ロック済みのウィンドウ

2. 前面パネルから画面にタッチしてシステムのロックを解除し、前面パネルのログイン画面を表
示します。

3. Log In をタッチします。

注: Username フィールドが空の場合は、Empower と入力します。

はじめに
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図 2-9 : フロントパネルへのログイン
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BioPhase 8800 システムのフロントパ
ネル 3
このセクションでは、BioPhase 8800 システムの前面パネルホームページで使用できるリボン、ス
テータスパネル、および機能について説明します。

図 3-1 : フロントパネルのホームページ

BioPhase 8800 システムのフロントパネル
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フロントパネル：リボン

図 3-2 : リボンの機能

項目 説明

1 タッチすると、光源の使用状況やソフトウェアのバージョンを確認したり、装置の電
源を切ったりできます。

2 タッチするとホームページが表示されます。

3 タッチするとダイレクトコントロール機能が表示されます。

4 タッチしてログを表示します。

5 カートリッジの状態を表示します。

注: カートリッジをセットすると、アイコンが緑色に変わります。

6 タッチすると、カートリッジの状態が LOADED または EJECTED に切り替わります。

7 タッチして UV ランプを ON または OFF にします。

注: ランプの電源をオンにすると、タイマーが 30 分からカウントダウンし、ランプが
使えるようになるまでの残り時間を示します。

8 タッチして LIF レーザーを ON または OFF にします。

注: レーザーの電源をオンにすると、タイマーが 15 分からカウントダウンし、ランプ
の準備が完了するまでの残り時間を示します。LIF 検出システムが装置に取り付
けられていない場合、LIF レーザー ボタンは使用できません。

フロントパネル：状態
前面パネル下部の状態パネルには、システムの情報や状態が表示されます。

BioPhase 8800 システムのフロントパネル
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図 3-3 : フロントパネルの状態

項目 説明

System Status

システムステータスを示します。

Action Progress

現在のサンプルセットメソッドの進行状況を表示します。

Method

装置のメソッド名を表示します。

サンプルの保存温度を表示します。

カートリッジの温度を表示します。

圧力を表示します。

キャピラリーの電圧を表示します。

キャピラリーの電流を表示します。

検出器のタイプを示します。

BioPhase 8800 システムのフロントパネル
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項目 説明

クーラントのレベルを示します。

注: 緑色は許容レベル、黄色は低レベル、赤色はクーラントが空であることを
示します。アイコンが赤色の場合、システムは動作しません。

実行中にエラーが発生したことを示します。

システムが Waters Empower™ソフトウェアによって制御されていることを示
します。

タッチすると前面パネルのタッチパネルがロックされます。

タッチするとログオフします。

タッチするとシステムが停止します。

サンプルセットメソッドが実行中の場合は、Waters Empower™ソフトウェアの

Run Samples ウィンドウで （Abort）をクリックします。

現在の日時を表示します。

フロントパネルの機能

図 3-4 : フロントパネルのホームページのボタン

BioPhase 8800 システムのフロントパネル
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項目 説明

Direct Control タッチすると、装置の手動制御のオプションが表示されます。次のセクシ
ョンを参照：ダイレクトコントロール。

追加の機能は BioPhase 8800 driver for Empower™ から入手できま
す。次のセクションを参照：Waters Empower™ソフトウェアのダイレクトコ
ントロール。

Log タッチすると前面パネルのログが表示されます。次のセクションを参照：
ログ。

ダイレクトコントロール

このセクションでは、BioPhase 8800 システムの前面パネルにあるダイレクトコントロール機能につ
いて説明します。

図 3-5 : ダイレクトコントロールウィンドウ

BioPhase 8800 システムのフロントパネル
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図 3-6 : Information

表 3-1 : ダイレクトコントロール機能

項目 説明

タッチして温度パラメータを表示または編集します。次のセクション
を参照：温度設定。

タッチして波長設定パラメータを表示または編集します。次のセク
ションを参照：波長設定。

タッチしてサンプルプレートを排出します。次のセクションを参照：
プレートのロードまたは排出。

タッチして試薬プレートを排出します。次のセクションを参照：プレ
ートのロードまたは排出。

タッチして試薬プレートとサンプルプレートをホーム位置に移動し
ます。次のセクションを参照：ホームへ移動。

温度設定

Set Temperature セクションで、サンプル保存とキャピラリーカートリッジの温度を調整します。
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図 3-7 : 温度設定

ラベル 説明

< Back タッチすると、Direct Control ウィンドウに戻ります。

Sample Storage
Temperature

タッチして、4 °C ～ 37 °C の間で温度値を設定します。 実際の温
度は、右側に°C で表示されます。

Capillary Cartridge
Temperature

タッチして、15 °C ～ 40 °C の間で温度値を設定します。実際の
温度は、右側に°C で表示されます。

Accept タッチしてすべての変更を受け入れます。

波長設定

Wavelength Settings セクションで、UV フィルターおよびレーザー誘導蛍光フィルターの波長を設
定します。ユーザーは、UV ランプ、UV フィルター、レーザー誘導蛍光フィルターの交換も行えま
す。

BioPhase 8800 システムのフロントパネル
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図 3-8 : UV Wavelength

ラベル 説明

< Back タッチすると、Direct Control ウィンドウに戻ります。

UV Filter 1

Filter Wavelength タッチして、フィルターの波長値を 200 nm ～ 400 nm の範囲で設
定します。

Serial Number タッチしてシリアル番号を設定します。

UV Filter 2

Filter Wavelength タッチして、波長値を 200 nm ～ 400 nm の範囲で設定します。

Serial Number タッチしてシリアル番号を設定します。

Done 操作完了後、Done をタッチして Direct Control ウィンドウに戻り
ます。

Replace Filter UV フィルターの装着を参照してください。

Replace UV Lamp UV ランプの装着を参照してください。

BioPhase 8800 システムのフロントパネル
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図 3-9 : LIF Wavelength

ラベル 説明

< Back タッチすると、Direct Control ウィンドウに戻ります。

Excitation Wavelength

Wavelength 波長はシステムに搭載されているレーザーから取得されます。

Emission Wavelength

Filter Wavelength タッチして、波長を 300 nm ～ 700 nm の範囲で設定します。

Serial Number タッチしてシリアル番号を設定します。

Done 操作完了後、Done をタッチして Direct Control ウィンドウに戻り
ます。

Replace Filter レーザー誘導蛍光検出器フィルターの取り付けを参照してくださ
い。

プレートのロードまたは排出

Direct Control ウィンドウから、サンプルや試薬プレートのロードや排出を行うことができます。

図 3-10 : Load or Eject the Plates
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ラベル 説明

Eject/Load Reagent タッチして試薬プレートをロードまたは排出します。

Eject/Load Sample タッチしてサンプルプレートをロードまたは排出します。

注: アイコンは、プレートを装着していないときは下向き矢印で表示され、装着すると自動的に上向
き矢印に切り替わります。

ホームへ移動

Transport Home ボタンを使用して、試薬プレートとサンプルプレートをホーム位置に移動します。
Transport Home をタッチすると、試薬プレートはホーム位置（カラム 1）へ、サンプルプレートは保
管位置へ移動します。

図 3-11 : 試薬トレイの位置

ログ
このセクションでは、前面パネルのログ機能について説明します。
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図 3-12 : 前面パネルの Events タブ

ラベル 説明

Initialize System タッチすると前面パネルのシステムが初期化されます。

注: 実行中にエラーが発生すると、前面パネルの状態領域に赤い
感嘆符アイコンが表示されます。システムを再初期化するには、
Initialize System をタッチします。

タッチするとログメッセージが削除されます。

BioPhase 8800 システムのフロントパネル
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図 3-13 : 前面パネルの System タブ

BioPhase 8800 Driver for Empower™のシステム
を設定
デフォルトでは、BioPhase 8800 システムは BioPhase ソフトウェアで使用するように設定されてい
ます。BioPhase 8800 Driver for Empower™のシステムを設定するには、次のステップを実行しま
す。

注: 以下に示すユーザー名とパスコードはデフォルトであり、変更されている可能性があります。

1. BioPhase 8800 システム前面パネルの Login ダイアログで、以下を実行します。

a. Username フィールドに、admin と入力します。

b. Passcode フィールドに、password と入力します。

c. Log In をタッチします。

2. Configuration をタッチします。

3. Network をタッチします。

4. Project Management セクションで、次を実行します。

a. Enable Third-Party Control チェックボックスをオンにします。

b. Third-Party Control リスト、Empower を選択します。

c. Save をタッチします。

5. BioPhase 8800 セクションで、次を実行します。

a. IP Address フィールドに、システムの IP アドレスを入力します。

Waters Empower™ソフトウェアでノードを設定するときに使用するのと同じ IP アドレスを
使用します。次のセクションを参照：ドキュメントの「ノードの を構成」：リリースノート。
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b. Subnet Mask フィールドに、255.255.255.0を入力します。

c. Save をタッチします。

図 3-14 : BioPhase 8800 Driver for Empower™のネットワーク設定

6. 電源を切り、BioPhase 8800 システムの電源を入れます。

a. タッチスクリーンの左上隅にあるシステム アイコンをタッチします。

図 3-15 : BioPhase 8800 システムアイコン

b. Power Off をタッチします。

c. システム前面の電源ボタンを押します。

BioPhase 8800 システムのフロントパネル
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Waters Empower™ソフトウェアのダイ
レクトコントロール 4
ダイレクトコントロールのステータスとボタン
Direct Control ペインの下部にあるステータス パネルには、システム情報とステータスが表示され
ます。

図 4-1 : BioPhase 8800 Driver for Empower™ダイレクトコントロールペイン

図 4-2 : ダイレクトコントロールステータスペイン

項目 説明

ステータスアイコン

サンプルの保存温度を表示します。

カートリッジの温度を表示します。

Waters Empower™ソフトウェアのダイレクトコントロール
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項目 説明

圧力を表示します。

キャピラリーの電圧を表示します。

キャピラリーの電流を表示します。

検出器のタイプを示します。

クーラントのレベルを示します。

注: 緑色は許容レベル、黄色は低レベル、赤色はクーラントが空であることを
示します。アイコンが赤色の場合、システムは動作しません。

ボタン

クリックして Trace View ウィンドウを開きます。

クリックして試薬プレートとサンプルプレートをホーム位置に移動します。

クリックすると、ダイレクトコントロール機能を停止します。

注: このボタンは実行を停止しません。実行を停止するには、Run Samples

ウィンドウで、 （Abort）をクリックします。
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ダイレクトコントロール：システムステータスタブ

図 4-3 : システムステータスタブ

ラベル 説明

Cartridge

Status カートリッジのステータスを表示します。

Type カートリッジの種類を表示します。

Load または Eject クリックすると、カートリッジがロックまたは排出されます。

Transport

Sample Plate サンプルプレートの位置を示します。

Load または Eject クリックして、サンプルプレートをロードまたは排出します。

Reagent Plate 試薬プレートの位置を示します。

Load または Eject クリックして試薬プレートをロードまたは排出します。

Light Source

UV Lamp UV ランプのステータスを表示します

Turn On または Turn Off クリックしてランプをオンまたはオフにします。

注: ランプの電源をオンにすると、タイマーが 30 分からカウントダ
ウンし、ランプが使えるようになるまでの残り時間を示します。

LIF Laser システムに LIF 検出器が取り付けられている場合は、レーザーの
ステータスが表示されます。
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ラベル 説明

Turn On または Turn Off クリックしてレーザーをオンまたはオフにします。

注: レーザーの電源をオンにすると、タイマーが 15 分からカウント
ダウンし、ランプの準備が完了するまでの残り時間を示します。
LIF 検出システムが装置に取り付けられていない場合、LIF レー
ザー ボタンは使用できません。

System Status システムステータスに関する情報を表示します。

Action Progress Status サンプルセットメソッドが実行中の場合、装置メソッドの現在のアク
ション、経過時間、およびアクションに関するその他の情報を表示
します。

メソッド サンプルセットメソッドが実行されている場合、装置メソッド名が表
示されます。

ダイレクトコントロール：Rinse タブ

図 4-4 : Rinse タブ

ラベル 説明

Pressure (psi) 圧力を psi 単位で入力します。

Duration (minutes) すすぎの時間を分単位で入力します。

Plate リンス液が入っているプレートをクリックします。オプションは
Sample と Reagent です。

Column リンス液が入っているカラムをクリックします。選択肢は 1 ～ 12
です。

Waters Empower™ソフトウェアのダイレクトコントロール

BioPhase 8800 システム BioPhase 8800 Driver for
Empower™システム用
42/107

オペレータガイド
RUO-IDV-05-15014-JA-A



ラベル 説明

Accept クリックするとすすぎ動作が始まります。

ダイレクトコントロール：Inject タブ

図 4-5 : Inject タブ

ラベル 説明

VOLTAGE クリックして、電圧注入を選択します。

Voltage (kV) 注入の電圧を kV 単位で入力します。

Duration (seconds) 注入時間を秒単位で入力します。

Polarity 電圧の極性をクリックします。オプションは Normal と Reverse で
す。

注: 注入に PRESSURE が選択されている場合、Polarity は有
効になりません。

Plate 注入するサンプルを含むプレートをクリックします。オプションは
Sample と Reagent です。

Column 注入するサンプルを含むカラムをクリックします。選択肢は 1 ～
12 です。

PRESSURE クリックして、圧力注入を選択します。

Pressure (psi) 注入の圧力を psi 単位で入力します。
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ラベル 説明

Accept クリックして注入を開始します。

ダイレクトコントロール：別途タブ

図 4-6 : 別途タブ

ラベル 説明

Voltage (kV) 電圧を kV で入力します。

Duration (minutes) 分離の時間を分単位で入力します。

Ramp Time (minutes) ランプ時間を分単位で入力します。

Polarity 電圧の極性をクリックします。オプションは Normal と Reverse で
す。

Plate 分離する溶液を含むプレートをクリックします。オプションは
Sample と Reagent です。

注: With Pressure がオフの場合、このオプションは使用できま
せん。

Column 分離する溶液を含むカラムをクリックします。選択肢は 1 ～ 12 で
す。

Accept クリックして分離を開始します。

With Pressure 電圧を印加しながらキャピラリーに圧力を加える場合に選択しま
す。
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ラベル 説明

Pressure (psi) 圧力を psi 単位で入力します。

注: With Pressure がオフの場合、このオプションは使用できま
せん。

方向 タッチして圧力の方向を選択します。オプションは Forward と
Both です。

注: With Pressure がオフの場合、このオプションは使用できま
せん。

ダイレクトコントロール：Temperature タブ

図 4-7 : Temperature タブ

ラベル 説明

Sample Storage Temperature

Set to: サンプル保管庫の温度を摂氏で入力します。

Capillary Cartridge Temperature

Set to: キャピラリーカートリッジの温度を摂氏で入力します。
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ダイレクトコントロール：ダイレクト設定タブ

図 4-8 : ダイレクト設定ボタン

ラベル 説明

Maximum current limit
(μA)

電流制限を μA 単位で入力します。すべてのキャピラリーの最大
電流は 600 μA です。

Data Collection Rate (Hz) リストからデータ収集速度を Hz 単位で選択します。 UV 検出の
場合、オプションは、1、2、4、および 8 です。LIF 検出の場合、オ
プションは 2、4、8、および 10 です。

注: ベースライン ノイズを減らすには、より低いデータ収集速度を
使用します。ピークを正確に特定するのに十分なポイントがない
場合は、より高いデータ収集率を使用します。

Peak Width @ 50% Height 予想される最も狭いピークの推定半値全幅 (FWHM) を秒単位で
入力します。

PMT Gain リストから PMT ゲインの値を選択します。オプションは、5、10、
100、および 1000 です。

注: サンプルの蛍光強度が高いと予想される場合は、低い値を使
用してください。サンプルの蛍光強度が低いと予想される場合は、
高い値を使用してください。
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ダイレクトコントロール：カートリッジ情報タブ

図 4-9 : カートリッジ情報タブ

ラベル 説明

Serial Number カートリッジのシリアル番号を表示します。

Lot Number カートリッジのロット番号を表示します。

Capillary Type キャピラリーのタイプを表示します。

Capillary Total Length キャピラリーの全長を cm 単位で示します。

Capillary Length to
Detector

検出器までのキャピラリーの長さを cm 単位で示します。

Capillary Internal
Diameter

検出器に対するキャピラリーの直径を µm 単位で示します。

Recorded Number of
Runs

記録された実行回数を示します。

First Use Date カートリッジが最初に使用された日付を示します。

Expiration Date カートリッジの有効期限を表示します。
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ダイレクトコントロール：波長設定タブ

図 4-10 : 波長設定ボタン

ラベル 説明

UV Lamp

Filter 1 Wavelength 最初のフィルターの波長を nm で示します。

Filter 2 Wavelength 第 2 のフィルターの波長を nm で示します。

Cumulative Use ランプの使用時間を表示します。

LIF Laser

Excitation Wavelength 励起波長を nm で表示します。

Emission Wavelength 発光波長を nm で表示します。

Cumulative Use レーザーの使用時間を表示します。

Waters Empower™ソフトウェアのダイレクトコントロール

BioPhase 8800 システム BioPhase 8800 Driver for
Empower™システム用
48/107

オペレータガイド
RUO-IDV-05-15014-JA-A



データの取得 5
Waters Empower™ソフトウェアからデータの取得を開始します。

試薬セットの追加
1. Waters Empower™Software project ウィンドウで、BioPhase 8800 > BioPhase

Instrument Method Editor をクリックします。

Method Editors for BioPhase System ソフトウェアが開き、Instrument Method Editor ワーク
スペースが表示されます。

2. リボンで をクリックし、次に Reagent Editor をクリックします。
試薬エディターが開き、Reagent Set Configuration タブが表示されます。

3. いずれかの試薬表に新しい試薬を追加するには、 をクリックします。
表に新しい行が表示されます。

4. 新しい行の Name 列に、新しい試薬の名前を入力します。

5. 新しい行の Viscosity 列に、新しい試薬の粘度を入力します。

デフォルトの粘度は 0.89 センチポイズです。

注: 一般的な粘度値のリストをツールチップに表示するには、粘度値の上にマウスを置きます。

6. Color 列をクリックし、リストから色を選択します。

ヒント! キット試薬キャップの色を選択します。

7. セット内の追加の試薬ごとに、ステップ 3 から 6 を繰り返します。

8. （オプション） をクリックすると、表から試薬が削除されます。

9. （オプション） をクリックすると、表へ試薬が復元されます。

10. Validation ペインが表示されている場合は、そのペインをクリックしてエラーを表示します。エラ
ーをクリックして発生した場所を強調表示し、必要な変更を行います。

エラーがない場合、Validation ペインは表示されません。

11. 試薬セットを保存します。

a. SAVE AS をクリックします。

注: エラーが発生した場合、SAVE AS ボタンは有効になりません。Validation ペインのエ
ラーをすべて解決し、SAVE AS をクリックします。

b. 異なる試薬に同じ色が割り当てられている場合は、メッセージが表示されます。色を同じに
する場合は、Yes をクリックします。
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このメッセージは、水など同じ試薬に「Water Dip 1」と「Water Dip 2」など異なる名前が付
けられている場合に表示されます。

Save Sample Set ダイアログが開きます。

c. Sample Set フィールドに名前を入力します。

d. Save をクリックし、OK をクリックして保存された試薬セットを確認します。

新しい装置メソッドを作成
装置メソッドは、BioPhase ソフトウェア メソッドをインポートして作成することもできます。次のセクシ
ョンを参照：BioPhase のソフトウェアメソッドをインポートして装置メソッドを作成。

1. Waters Empower™Software project ウィンドウで、BioPhase 8800 > BioPhase Method
Editor をクリックします。
Method Editors for BioPhase System ソフトウェアが開き、Instrument Method Editor ワーク
スペースが表示されます。

2. New Instrument Method をクリックします。
Instrument Method Editor が Method Settings を前面にして開きます。

3. Reagent Set リストをクリックし、試薬セットを選択します。
Inlet Reagents from Reagent Set と Outlet Reagents from Reagent Set 表が読み込まれま
す。

4. Method Settings フィールドで情報を入力または選択します。次のセクションを参照：

5. メソッドを構築するには、Method Program タブを開き、アクションを Program ペインにドラッグ
します。次のセクションを参照：

3 種類のメソッドが作成可能です。

• 分離メソッド：注入アクションがあるメソッドで、サンプルのデータを取得するために使用しま
す。

• コンディショニングメソッド：注入アクションのないメソッドで、分離メソッドを実行してデータを
取得する前にキャピラリーを調製するために使用します。

• シャットダウンメソッド：注入アクションのないメソッドで、カートリッジの寿命を保つためにキャ
ピラリーを洗浄し、光源をオフにするために使用します。

ヒント! メソッドの最後にアクションを追加するには、アクションをダブルクリックします。右クリッ
ク メニューを使用して、Program ペインからアクションをコピー、貼り付け、または削除します。
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図 5-1 : アクションと Program ペイン

6. Program ペインでアクションをクリックし、Parameters ペインでアクションパラメータを編集しま
す。次のセクションを参照：

必要に応じて、Method Settings タブの Inlet Reagents from Reagent Set 表と Outlet
Reagents from Reagent Set 表に追加の試薬を追加できます

注: 変更は試薬セットに保存されません。新しい試薬を後で使用する場合は、新しい試薬セット
を作成します。次のセクションを参照：試薬セットの追加。

7. 試薬プレート内の試薬の位置を編集するには、次の手順を実行します。

a. Reagent Plate Setup タブが開きます。

b. 試薬の Column をクリックし、リストから列を選択します。

各列には 1 つの試薬のみを割り当てることができます。

8. Validation ペインが表示されている場合は、そのペインをクリックしてエラーを表示します。エラ
ーをクリックして発生した場所を強調表示し、必要な変更を行います。

エラーがない場合、Validation ペインは表示されません。

9. メソッドを保存します。

a. SAVE AS をクリックします。

注: エラーが発生した場合、SAVE AS ボタンは有効になりません。Validation ペインのエ
ラーをすべて解決し、SAVE AS をクリックします。

Save Instrument Method ダイアログが開きます。

b. Method Name フィールドに名前を入力します。

注: Save ボタンを有効にするには、メソッド名が一意である必要があります。

c. （オプション）Description フィールドにメソッドの説明を入力します。

d. Save をクリックし、OK をクリックして保存されたメソッドを確認します。

メソッドは Waters Empower™ソフトウェアデータベースに保存されます。

10. Method Editors for BioPhase System ウィンドウ内で、右上隅のクローズ ボックスの[×] をク
リックします。
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Method Editors for BioPhase System ソフトウェアが終了し、project ウィンドウが表示されま
す。

Waters Empower™ソフトウェアで装置メソッドを使用するには、必ずそのメソッドをメソッド セットに
追加してください。次のセクションを参照: メソッドセットの作成。

BioPhase のソフトウェアメソッドをインポートして装置
メソッドを作成
次のステップを使用して、BioPhase ソフトウェアメソッドをインポートし、Waters Empower™ソフトウ
ェアで使用できる装置メソッドを作成します。

1. Waters Empower™ Software Project ウィンドウで、File > New Method > Instrument
Method をクリックします。

図 5-2 : Select Desired Chromatography System ダイアログ

2. 使用するシステムをクリックし、OK をクリックします。
Instrument Method Editor が開きます。

3. Import をクリックし、コンディショニング メソッドを参照します。
メソッドは、Method Settings タブが前面にある Instrument Method Editor ウィンドウで開きま
す。

注: このウィンドウは読み取り専用です。メソッドの変更が必要な場合は、装置メソッドを保存
し、Method Editors for BioPhase System ソフトウェアでメソッドを編集します。次のセクション
を参照：ドキュメントの「既存の装置メソッドを編集」: ソフトウェアヘルプ。
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図 5-3 : 装置メソッドエディターの Method Settings タブ

4. （オプション）Method Program タブを開いてアクションを確認します。

5. アクションのパラメータを表示するには、表内の行をクリックします。
Parameters ペインが更新されてパラメータが表示されます。

図 5-4 : 装置メソッドエディターの Method Program タブ

6. 装置メソッドを保存します。

a. File > Save with Method Set をクリックします。
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Save current Instrument Method ダイアログが開きます。

b. Name フィールドに名前を入力します。

注: 名前は 30 文字未満である必要があり、英数字、スペース、特殊文字 @、_、%を含め
る必要があります。Waters Empower™ソフトウェアの一部のバージョンでは、30 文字を超
える文字やその他の特殊文字を使用できますが、メソッドを Method Editors for
BioPhase System ソフトウェアで編集すると、それらの文字が問題を引き起こす可能性が
あります。

c. （オプション）Method Comments フィールドをクリックし、情報を入力します。

d. プロンプトが表示されたら、Password フィールドに現在のユーザーの Waters Empower
™ソフトウェアのパスワードを入力し、Save をクリックします。

装置メソッドとファイルメソッドセットが現在のプロジェクトに保存されます。

7. File > Exit をクリックします。

注: メソッドをインポートした後は、ウィンドウを閉じてから開かない限り、Instrument Method
Editor ウィンドウの Import ボタンは使用できなくなります。

メソッドセットの作成
装置メソッドごとに、メソッドセットが必要です。

注: メソッドセットには、処理メソッド、レポートメソッド、およびエクスポートメソッドも含めることができ
ます。これらのメソッドを作成するには、Waters Empower™ソフトウェアに付属のドキュメントを参照
してください。

1. Waters Empower™ Software Project ウィンドウで、File > New Method > Method Set をク
リックします。

2. メッセージで、No をクリックします。
Method Set Editor ウィンドウが開きます。

3. Instrument Method リストで、装置メソッドを選択します。その他のパラメータは変更しないで
ください。
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図 5-5 : Method Set Editor ウィンドウ

4. メソッドセットを保存します。

a. File > Save をクリックします。

b. Name フィールドに、メソッドセットの名前を入力します。

c. （オプション） メソッドのコメントフィールドに情報を入力します。

d. プロンプトが表示されたら、Password フィールドに現在のユーザーの Waters Empower
™ソフトウェアのパスワードを入力し、Save をクリックします。
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図 5-6 : Save current method set ダイアログ

メソッドセットは現在のプロジェクトに保存されます。

サンプルセットメソッドを作成
データ取得のために BioPhase 8800 システムに送信されるサンプルと関連するメソッドセットのリ
スト。

注: サンプル セット メソッドは Waters Empower™ ソフトウェアでも作成できますが、プレート レイア
ウトを作成し、BioPhase 8800 システムで使用するサンプル セット メソッドを検証できるのは
Method Editors for BioPhase System ソフトウェアのみです。

サンプル セット メソッドの作成

注: サンプルセットメソッドにはメソッドセットが必要です。必要な装置メソッドがメソッドセットの一部
であることを確認します。

サンプルセットメソッドにおけるサンプルとメソッドセットの配置は、データ取得の期間に影響します。
次のセクションを参照：サンプルセットメソッドの設定ためのヒント。

1. Waters Empower™Software Run Samples ウィンドウで、BioPhase 8800 > BioPhase
Sample Set Editor をクリックします。

Method Editors for BioPhase System ソフトウェアが開き、Sample Set Method Editor ワー
クスペースが表示されます。

2. New Sample Set Method をクリックします。
Sample Set Method Editor が開き、Sample Plate Setup タブが表示されます。
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3. Sample Set Summary 表の最初の行で、Method Set Name セルをクリックし、適切なコンデ
ィショニング メソッドを選択します。

4. Sample Plate Layout ペインで、サンプルを追加するウェルを選択します。

• 個別のウェルをクリックします。

• カラム内のすべてのウェルを選択するには、カラム番号をクリックします。

図 5-7 : Sample Plate Layout ペイン

Sample Plate Layout が更新され、選択したウェルが表示されます。

5. 必要に応じて、サンプル セット メソッドからウェルを削除するには、Sample Set Summary 表
の行を右クリックし、Delete Row を選択します。

すべてのウェルを削除するには、NEW をクリックし、新しいサンプル セット メソッドを作成しま
す。

6. 必要なサンプル情報を、Sample Set Summary 表に追加します。サンプルが含まれる行で、
次の操作を実行します:

ヒント! Excel からコピーした情報を貼り付けることで、必要な情報を追加することもできます。
Plate/Well セルをクリックし、Ctrl-V を押して Excel から情報を貼り付けます。コピーされたテ
キストには、ウェル、サンプル名、およびメソッドセット名が含まれている必要があります。メソッ
ド セットが Empower データベースに存在しない場合、サンプルセット表のメソッド セット セル
は、貼り付け後に空白になります。

a. Sample Name、セルにサンプルの名前を入力します。

b. Method Set Name セルをクリックし、リストから適切な分離メソッドを選択します。

データの取得

オペレータガイド
RUO-IDV-05-15014-JA-A

BioPhase 8800 システム BioPhase 8800 Driver for
Empower™システム用

57/107



ヒント! 最初のサンプル行のメソッドを選択し、右クリックして Apply method to all
samples in column を選択して、そのメソッドを列内のすべてのサンプルに割り当てま
す。

7. すべてのサンプルにメソッドセットが割り当てられるまで、前のステップを繰り返します。

8. 最後の行の Sample Set Method セルをクリックし、適切なシャットダウン方法を選択します。

図 5-8 : Sample Set Summary 表

9. Validation ペインが表示されている場合は、そのペインをクリックしてエラーを表示します。エラ
ーをクリックして発生した場所を強調表示し、必要な変更を行います。

エラーがない場合、Validation ペインは表示されません。

10. サンプルセットメソッドを保存します。

a. SAVE AS をクリックします。

注: エラーが発生した場合、SAVE AS ボタンは有効になりません。Validation ペインのエ
ラーをすべて解決し、SAVE AS をクリックします。

Save Sample Set ダイアログが開きます。

b. Sample Set Name フィールドに名前を入力します。

注: 名前は 30 文字未満である必要があり、英数字、スペース、特殊文字 @、_、%を含め
る必要があります。Waters Empower™ソフトウェアの一部のバージョンでは、30 文字を超
える文字やその他の特殊文字を使用できますが、メソッドを Method Editors for
BioPhase System ソフトウェアで編集すると、それらの文字が問題を引き起こす可能性が
あります。

c. （オプション） Description フィールドに情報を入力します。

d. Save をクリックし、OK をクリックして保存されたメソッドを確認します。

サンプルセットメソッドは、Waters Empower™ソフトウェアデータベースに保存されます。

11. プレート レイアウトを表示、保存、または印刷するには：

a. Plate Layouts タブを開きます。
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b. (オプション) PRINT をクリックします。
Print Preview ダイアログが開きます。

c. 必要に応じて、ボタンをクリックしてプレート レイアウトを印刷または保存します。

次のセクションを参照：ドキュメントの「印刷プレビュー ダイアログ」：ソフトウェア ヘルプ シ
ステム。

d. 右上隅のクローズボックス、[×]をクリックします。
Print Preview ダイアログが閉じます。

12. Method Editors for BioPhase System ウィンドウ内で、右上隅のクローズ ボックスの[×] をク
リックします。
Method Editors for BioPhase System ソフトウェアが終了し、Run Samples ウィンドウが表示
されます。

サンプルセットメソッドの設定ためのヒント

サンプル セット メソッドでのサンプルの順序は、実行回数、つまり必要な時間に影響します。
BioPhase 8800 システムは、各ウェルに割り当てられたメソッドセットに関係なく、8 本すべてのキャ
ピラリーから同時にデータを取得するように設計されています。カラムの各ウェルに異なるメソッドセ
ットが割り当てられている場合、8 回の個別の実行が行われます。

サンプルセットメソッドの実行に必要な時間を最小限に抑えるには、次の推奨事項を使用してくださ
い。

• 新しい実行を開始しないようにするには、同じメソッドセットを持つサンプルを同じ列（または複数
の列）にグループ化します。複数のメソッドセットを使用する場合は、同じメソッドセットを使用する
サンプルを隣接するウェルに入れます。

• 必要なサンプル量を最小限に抑えるため、カラムごとに複数のメソッドセットを割り当てないでく
ださい。

新たな実行の原因

現在のサンプルウェルが次の場合、新しい実行が行われます。

• プレートの別のカラムにあります。

• 前の実行と同じウェルです。

• 前の実行と前のウェルです。たとえば、前のサンプルウェルは D1 で、現在のサンプル ウェルは
A1 です。

• 前の実行とは異なるメソッドが設定されています

次の例は、ソフトウェアが別の実行を開始するタイミングを決定する方法を示しています。サンプル
セットメソッドではウェル A1 が最初のウェルであると仮定します。

1. コンディショニングの後、サンプル セット メソッドは、カラム 1 の 8 つのウェルすべて (ウェル
A1 からウェル H1) にサンプルを注入するように BioPhase 8800 システムに指示し、ウェル
A1 に割り当てられたメソッド セットを使用してデータを取得します。

2. ソフトウェアはウェル A1 のデータを保存し、ウェル B1~H1 のデータをメモリに保存します。

3. ソフトウェアはサンプル セット メソッドで次の行を評価します。
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• ウェルが B1 で、メソッドセットが次の場合：

• A1 の場合と同様に、ウェル B1 のデータが保存され、次にソフトウェアがサンプルセット
法の次の行を評価します。このステップは、カラム全体のデータが保存されるか、次のウ
ェルに別のメソッドセットが含まれるまで繰り返されます。

• A1 とは異なり、メモリ内のデータが削除され、新しい実行が開始されます。サンプルはカ
ラム 1 の 8 つのウェルすべてから注入されます。

• ウェルが B1 ではない場合:

• ウェルが A1（複製）の場合、メモリ内のデータは削除され、新しい実行が開始されます。
サンプルはカラム 1 の 8 つのウェルすべてから注入されます。

• ウェルがカラム 1 にあり、メソッドセットが次の場合:

• A1 と同様に、メモリ内のデータが保存され、ソフトウェアはサンプルセットメソッドで次
の行を評価します。

• A1 とは異なり、メモリ内のデータが削除され、新しい実行が開始されます。サンプル
はカラム 1 の 8 つのウェルすべてから注入されます。

• ウェルがカラム 1 にない場合は、メモリ内のデータが削除され、新しい分析が開始されま
す。サンプルは、ウェルが配置されているカラム内の 8 つのウェルすべてから注入され
ます。

4. 実行が完了すると、ソフトウェアは現在のウェルのデータを保存します。次に、前述のように、
サンプルセットメソッドの次の行を評価します。ただし、ウェルはカラムの次のウェルであり、B1
ではありません。次のステップを参照：3。

BioPhase 8800 システム用の準備
このセクションの手順で、BioPhase 8800 システムのデータ取得の準備をします。

このセクションの手順は、システムがすでに適切にインストールされ、初期化されていることを前提
としています。

ヒント! 時間を節約するために、実行を開始する 30 分前に光源をオンにして、ウォームアップしてお
きます。

試薬のインレットとアウトレットのプレートをセット

注: 気泡を防ぐには、緩衝液を振ったり、激しく混ぜたりしないでください。気泡は分離不良の原因
になることがあります。

1. 試薬プレートレイアウトに従って、試薬インレットおよびアウトレットのプレートに試薬を加えま
す。

次の表の量を使用します。

注: アウトレットプレートの場合は、面取りされた角が右上にあることを確認してから、プレート
の左側のウェルのみを充填します。右側のウェルはオーバーフロー用であり、空である必要が
あります。
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表 5-1 : 試薬インレットプレートと試薬アウトレットプレートの試薬

プレート 試薬

インレットプレー
ト

ウェルあたり 800 µL

アウトレットプレ
ート

• 分離または待機のための試薬ウェルあたり 2.8 mL

• 廃棄位置の CE Grade Water のウェルあたり 1.5 mL

2. プレートにフィルムカバーを付けます。

注意: システムに損傷を与える恐れ。加熱プレートシーラーを使用してシールを貼らないでくだ
さい。熱によりプレートの表面が損傷し、圧力システムに問題が発生する可能性があります。

注: USA Scientific の X-Pierce フィルムのみが検証されています。別のフィルムを使用する場
合は、使用前にテストしてください。

3. プレートをスイングバケットローターに入れ、30 g で 4 分間回転させます。バケットのバランス
が良いことを確認します。

注意: 結果が不正確になる可能性。必ずプレートを回転させて気泡を取り除いてからシステム
にセットしてください。気泡があると、分離に失敗することがあります。

4. プレート内に気泡がないことを確認してください。気泡がある場合は、相対遠心力（RCF）を大
きくして再度プレートを回転させます。

試薬プレートの場合、最大 RCF は 1,000 g です。サンプルプレートの場合、最大 RCF は
375 g です。

5. 前面パネルで Eject Reagent をタッチします。

図 5-9 : Eject Reagent ボタン

プレートコンパートメントが開きます。

6. プレートからフィルムカバーを取り外します。

注意: システムに損傷を与える恐れ。フィルムカバーを取り外す前に、プレートをシステムにロ
ードしないでください。運転中にフィルムカバーが存在すると、キャピラリーチップが損傷する可
能性があります。

7. プレートコンパートメントにすでに試薬プレートがある場合は、試薬プレートを取り外してくださ
い。

8. 試薬注入プレートのノッチをタブに合わせて、プレートをプレートキャリアに置きます。次の図を
参照：図 2-6。
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9. 試薬アウトレットプレートの面取りされた角が左上にあることを確認して、プレートをプレートキャ
リアの背面に置きます。次の図を参照：図 2-7。

10. Load Reagent をタッチします。

図 5-10 : Load Reagent ボタン

プレートコンパートメントが閉じます。

サンプルのインレットとアウトレットのプレートをセット

1. サンプルプレートレイアウトに従って、サンプルをサンプルインレットプレートに加えます。

最小サンプル量は 50 µL です。 最大サンプル量は 200 µL です。

推奨サンプル量は用途によって異なります。該当するアプリケーションガイドを参照してくださ
い。

2. キャピラリーの損傷を防ぐため、すべてのウェルにサンプルがないカラムがある場合は、各空
のウェルに 100 μL から 200 μL のサンプル緩衝液を加える。

カラムにサンプルがない場合、ウェルは空のままにすることができます。

3. サンプルレイアウトに従って、試薬をサンプルアウトレットプレートに加えます。

最大容量は 2.0mL です。

推奨量は用途によって異なります。該当するアプリケーションガイドを参照してください。

注: アウトレットプレートの場合は、面取りされた角が右上にあることを確認してから、プレート
の左側のウェルのみを充填します。右側のウェルはオーバーフロー用であり、空である必要が
あります。

4. プレートにフィルムカバーを付けます。

注意: システムに損傷を与える恐れ。加熱プレートシーラーを使用してシールを貼らないでくだ
さい。熱によりプレートの表面が損傷し、圧力システムに問題が発生する可能性があります。

注: USA Scientific の X-Pierce フィルムのみが検証されています。別のフィルムを使用する場
合は、使用前にテストしてください。

5. プレートをスイングバケットローターに入れ、30 g で 4 分間回転させます。バケットのバランス
が良いことを確認します。

注意: 結果が不正確になる可能性。必ずプレートを回転させて気泡を取り除いてからシステム
にセットしてください。気泡があると、分離に失敗することがあります。

6. プレート内に気泡がないことを確認してください。気泡がある場合は、相対遠心力（RCF）を大
きくして再度プレートを回転させます。
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試薬プレートの場合、最大 RCF は 1,000 g です。サンプルプレートの場合、最大 RCF は
375 g です。

7. 前面パネルで Eject Sample をタッチします。

図 5-11 : Eject Sample ボタン

プレートコンパートメントが開きます。

8. プレートからフィルムカバーを取り外します。

注意: システムに損傷を与える恐れ。フィルムカバーを取り外す前に、プレートをシステムにロ
ードしないでください。運転中にフィルムカバーが存在すると、キャピラリーチップが損傷する可
能性があります。

9. プレートコンパートメントにすでにサンプルプレートがある場合は、サンプルプレートを取り外し
てください。

10. サンプルプレートのアライメントノッチがタブと合うように向けて、プレートをプレートキャリアにセ
ットします。次の図を参照：図 2-5。

11. サンプルアウトレットプレートの面取りされた隅が左上になるように向けて、プレートキャリアの
奥にプレートをセットします。次の図を参照：図 2-7。

12. Load Sample タッチします。

図 5-12 : Load Sample ボタン

プレートコンパートメントが閉じます。

キャピラリーカートリッジの検査

警告! 尖った部分により怪我をする危険。カートリッジの取り扱いは慎重に行ってください。
キャピラリー先端は非常に尖っています。

注意: システムに損傷を与える恐れ。電極、キャピラリーの端、カートリッジシール、またはカートリッ
ジ本体で分離ゲルまたはその他の試薬を結晶化させないでください。電解質の塩の結晶または沈
殿物は、キャピラリーの詰まり、不適切な圧力シール、サンプル注入時のエラー、アーク放電、また
は漏電を引き起こす可能性があります。

1. 使用前に、電極、キャピラリーチップ、カートリッジシール、カートリッジ本体のインターフェース
を検査してください。
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2. カートリッジの外側に液体が付着している場合は、湿らせた糸くずの出ないラボ用の布でカート
リッジをクリーニングします。クリーニング後は、必ずカートリッジを乾燥させます。

注: カートリッジのクリーニングに石鹸や洗剤は使用しないでください。

3. キャピラリーチップが塞がっている場合は、次の手順を行います。

a. CE Grade Water を使用して、キャピラリーのインレットを洗浄します。

b. 糸くずの出ないラボ用の布を使って、キャピラリーのインレットを外側に向けて丁寧に拭き
ます。

4. 拡大鏡を使って、キャピラリーウィンドウの両側を点検してください。糸くずなどが付着している
場合は、電子機器用の圧縮空気を短時間噴射して除去します。キャピラリーウィンドウのクリー
ニングには、水またはその他の液体を使用しないでください。

注意: システムに損傷を与える恐れ。キャピラリーウィンドウのクリーニングに、メタノール、アセ
トンなどの有機溶剤を使用しないでください。有機溶剤は接着剤を溶かしてしまい、キャピラリ
ーウィンドウに残留物が残り、検出器に干渉する可能性があります。

5. 糸くずの出ないラボ用の布または綿棒をエタノールまたはイソプロピルアルコールで湿らせ、チ
ップの表面を拭きます。カートリッジを取り付ける前に、チップを自然乾燥させてください。

カートリッジの取り付け

警告! 尖った部分により怪我をする危険。カートリッジの取り扱いは慎重に行ってください。
キャピラリー先端は非常に尖っています。

警告! 挟み込みの危険。前面パネルを開けるときは、前面パネルの左側に指を入れないよ
うに注意してください。

注意: システムに損傷を与える恐れ。カートリッジを取り付ける前に、試薬プレートがシステムに取り
付けられていることを確認してください。取り付けていないとカートリッジが損傷する恐れがありま
す。

1. カートリッジが冷蔵庫に保管されていた場合は、システム内の結露を防ぐために、カートリッジ
を室温に均衡させます（約 30 分）。

2. ウェットトレイからカートリッジを取り外します。

3. アーク放電を防ぐために、使い捨てのラボ用の布を使用してカートリッジ本体を乾燥させます。

4. カートリッジの底面を上に向けます。

5. 糸くずの出ないラボ用の使い捨ての布を使用して、キャピラリーと電極がカートリッジから出て
いる部分をやさしく拭きます。シールを損傷しないように注意してください。
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図 5-13 : カートリッジの底部

項目 説明

1 アウトレットプレートシール

2 インレットプレートシール

6. 試薬プレートがシステムに装着されていない場合は、装着します。次のセクションを参照：試薬
のインレットとアウトレットのプレートをセット。

7. 前面パネルを開いて、カートリッジをシステムにセットします。

8. 前面パネルを閉じ、EJECTED をタッチしてカートリッジをロックします。

図 5-14 : イジェクトボタン

カートリッジの寿命を超えた場合は、警告メッセージが前面パネルのログに追加されます。警

告メッセージを表示するには、前面パネルのステータス領域で  をタッチします。カートリッジ
はそのまま使用することも、新しいカートリッジを取り付けることもできます。
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システムは、キャピラリーがカラム 1 の上に位置するように試薬プレートを移動し、プレートを上
昇させて、キャピラリーの両端が CE Grade Water に浸るようにします。

9. 前面パネルのクーラントレベルを検査します。必要に応じて、システムの注入口にクーラントを
追加します。

次のセクションを参照：キャピラリーカートリッジクーラントの追加。

サンプルセットメソッドを開始
1. カートリッジとプレートをロードします。次のセクションを参照：BioPhase 8800 システム用の準

備。

2. Waters Empower™ソフトウェア Project ウィンドウで、Tools > Run Samples をクリックしま
す。

図 5-15 : Select Desired Chromatography System ダイアログ

3. 使用するシステムをクリックし、OK をクリックします。
Run Samples ウィンドウが開きます。

4. プレートタイプを設定します。

a. Edit > Plates をクリックします。
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図 5-16 : Define Plates for Sample Set Method ダイアログ

注: ダイアログが前の図のように表示されない場合は、2790 Layout チェックボックスをオ
フにします。

b. Plate Type Name セルをクリックし、ANSI-96well2mL を選択します。
ダイアログが更新され、プレートの画像とプレートシーケンスモードのボタンが表示されま
す。

c. Plate Layout Position セルをクリックして、1 と入力します。

d. をクリックして、実行中のウェルへのアクセス順を表示します。

e. OK をクリックして変更を保存し、ダイアログを閉じます。

ヒント! プレートの種類を永続的に設定するには、Customize > Defaults をクリック、 Plates
をクリックして、4.e からステップ 4.b を実行し、OK をクリックします。

Sample Set Method 表で、Vials 列の見出しが Plate/Well に変わります。

5. (Load Sample Set) をクリックします。
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図 5-17 : Load Samples ダイアログ

6. Load using a previously created sample set method をクリックし、OK をクリックします。

図 5-18 : Open an existing sample set method ダイアログ

7. リストでサンプルセットメソッドをクリックし、Open をクリックします。
サンプルセットメソッドが Samples タブで開きます。

8. (オプション) BioPhase 8800 システムに関連する列のみを表示するように表を構成します。

a. 右クリックして、Table Properties を選択します。
Table Properties ダイアログが開きます。

b. Hide All をクリックし、 Plate/Well、# of Injs、SampleName、Function、および
Method Set / Report or Export Method のチェックボックスをオフにします。
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c. OK をクリックします。

表が更新され、選択した列が表示されます。

図 5-19 : Samples タブ

9. サンプルセットメソッドを確認します。変更が必要な場合は、Method Editors for BioPhase
System ソフトウェアでメソッドを編集します。装置メソッドまたはメソッドセットの変更は、自動的
にサンプルセットのメソッドに反映されます。

10. Waters Empower™ Software Project ウィンドウで、 （Start）をクリックします。
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図 5-20 : サンプルセットの実行ダイアログ

11. 必要に応じて、Run Sample Set ダイアログで情報を編集します。

a. 必要に応じて、Name for this sample set フィールドを編集します。

b. Shutdown Method をクリックし、キャピラリーをすすぐ装置メソッドを選択します。

注: リンス液は必ず使用するキャピラリーに適合したものを使用してください。

実行中にエラーが発生した場合、システムはこの装置メソッドを実行し、その後実行を停
止します。

c. 必要に応じて、Do Not Run Shutdown Method During User Abort を選択します。

d. Run をクリックします。

実行が開始されます。実行中、測定中のサンプルの Sample Set Method ウィンドウの行内の
テキストが赤色で表示されます。

注意: データ損失の可能性。Empower 用の BioPhase 8800 driver for Empower™ システ
ムステータスがアイドル状態であっても、実行中の Direct Control ペイン。いかなるアクション
もデータの取得を妨げる可能性があります。
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Waters Empower™ソフトウェアで実行をモニタ
この手順を使用して、サンプル セットメソッドの進行状況をモニタし、必要に応じて一時停止または
停止します。

注: Waters Empower™ソフトウェアのほとんどのペインはクロマトグラフィー用に設計されていま
す。次のステップに従って、キャピラリー電気泳動分離の進行状況を監視し、Time Remaining およ
び Solvent Required ペインの情報を無視します。

1. 問題が検出された場合は、 （Abort）をクリックして実行を中止します。

注意: データ損失の可能性。すべてのデータが保存されるまで実行を停止しないでください。次
の行にサンプルセットメソッドがあるときにデータが保存されます。

注: Direct Control ペインの Stop ボタンは使用しないでください。このボタンは、Direct
Control ペインから開始された機能に対してのみ動作します。

図 5-21 : Abort Options ダイアログ

注意: システムに損傷を与える恐れ。実行が停止した場合は、カートリッジを再度使用する前
に、コンディショニング方法を使用してキャピラリーをすすぎます。キャピラリーがすすがれてい
ない場合、電解質の塩の結晶または沈殿物が蓄積し、キャピラリーの詰まり、不適切な圧力シ
ール、サンプル注入時のエラー、アーク放電、または漏電を収集および引き起こす可能性があ
ります。

実行が終了すると、Sample Set Method ウィンドウのすべての行内のテキストが赤色になりま
す。

2. データの取得中にデータを表示するには、Direct Control ペインで （Monitor）をクリック
します。
Trace View ウィンドウが開き、データが表示されます。
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図 5-22 : Trace View ウィンドウ

3. 必要に応じて、次のいずれかを行います。

• 電流、電圧、または圧力を表示するには、左上の該当するタブを開きます。

• すべてのキャピラリーのデータを含む 1 つのグラフを表示するには、左下の Overlay をクリ
ックします。

• 特定のキャピラリーのデータを表示するには、ウィンドウの下部にあるチェックボックスをオ
ンまたはオフにして、目的のキャピラリーを選択します。

• トレース上の任意の点の時間と検出器の値を表示するには、目的の位置でトレースをクリッ
クします。

• データをズームするには、Overlay が選択されていることを確認し、ドラッグしてズームする
エリアを選択します。マウスのスクロールホイールを使用してズームすることもできます。

• データを元のサイズに戻すには、右下の Reset Zoom をクリックします。

• ズームしたプロットの別の領域を表示するには、X 軸または Y 軸を右クリックしてドラッグし
ます。

4. 必要に応じて、右下にある Auto Zero をクリックします。
検出器信号はゼロに設定されます。

5. Abort ボタン（ ）が赤から緑（ ）に変わるまで待ちます。

データの取得からすべてのデータが保存されるまでに時間がかかる場合があります。緑色の
ボタンは、すべてのデータが保存されたことを示します。
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6. 必要に応じて、サンプルと試薬を廃棄します。次のセクションを参照：ドキュメントの「廃棄物処
理」：アプリケーションガイド。

7. 必要に応じて、カートリッジを保管します。次のセクションを参照： 実行後にカートリッジを保管。

実行後にカートリッジを保管

警告! 尖った部分により怪我をする危険。カートリッジの取り扱いは慎重に行ってください。
キャピラリー先端は非常に尖っています。

カートリッジを 3 日間未満保管

1. サンプルセットメソッドにシャットダウンメソッドが含まれていない場合は、シャットダウンメソッド
を使用してキャピラリーをクリーニングします。

2. キャピラリーの両端を CE Grade Water に浸した状態で、カートリッジをシステムに最大 3 日
間保管します。

注: カートリッジを 3 時間以上使用しなかった場合は、分離を行う前にコンディショニングメソッ
ドを実行してください。

カートリッジを 3 日間以上保管

1. シーケンスまたはサンプルセットメソッドにシャットダウンメソッドが含まれていない場合は、シャ
ットダウンメソッドを使用してキャピラリーをクリーニングします。

2. BioPhase 8800 システム前面パネルのリボンで、 （Loaded）をタッチして約 1 分間
待ちます。

カートリッジを取り外す前に、クーラントがクー ラントリザーバーに戻るのを待ちます。

3. システムからカートリッジを取り外し、キャピラリーの両端を CE Grade Water に浸した状態で
カートリッジボックスに真っすぐ立てて、2 ℃ ～ 8 ℃ で保管します。

注: トレイ内の微生物増殖を防ぐため、トレイ内の CE Grade Water は定期的に交換します。

保管後のカートリッジを準備

• カートリッジを 1 日以上使用していないか、長期間保管していた場合は、 コンディショニングメソ
ッドを使用してキャピラリーを調整します。

注: アークを防止するために、カートリッジをシステムに取り付ける前に、電極とカートリッジ本体の
周りの水を注意深く拭き取ってください。
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メンテナンス 6
警告! イオン化放射線障害の危険、生物学的危険、または有害化学物質の危険。クリ
ーニングまたはメンテナンスを行う前に、汚染除去が必要か判断してください。放射性
物質、生物学的病原体、または有害化学物質が質量分析装置に使用された場合、お
客様はクリーニングまたはメンテナンス前にシステムに対して汚染除去を行う必要があ
ります。

表面のクリーニング
溶液がこぼれたり、または汚れた場合には、システムの外面を清掃してください。

必要な資材

• 柔らかい布

1. 水で湿らせた柔らかい布でシステムの表面を拭いてください。

2. 乾いた柔らかい布で表面の水分を取り除いてください。

キャピラリーカートリッジクーラントの追加

必要な資材

• キャピラリーカートリッジクーラント（PN 359976）

• 充填ツール（PN 144647）

1. BioPhase 8800 システム前面パネルでクーラントのレベルを確認します。
カートリッジクーラントのレベルが赤の場合は、クーラントを追加します。

2. パネルを左側に移動して、クーラント注入口にアクセスできるようにします。

3. 充填ツールを注入口に取り付けます。

4. シリンジの端を持ち、インジケータを見ながら、必要な充填量に達するまでゆっくりとクーラント
を注入します。

5. シリンジから排液します。

6. カートリッジクーラントのレベルが緑になるまで、ステップ 4 と 5 を繰り返します。
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図 6-1 : クーラント注入口

項目 説明

1 クーラント注入口

サンプル蓋とプレートコンパートメントカバーをクリーニ
ング
定期的にサンプルの蓋を取り外して検査してください。必要に応じて、サンプル蓋とプレートコンパ
ートメントカバーをクリーニングします。

必要な資材

• 湿らせた布

• 乾いた布

• （オプション）ラボ組織

1. 前面パネルで、Eject Sample または Eject Reagent をタッチします。
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プレートコンパートメントのカバーが自動的に開き、プレートコンパートメントが見える状態になり
ます。

図 6-2 : プレートコンパートメントが開く

2. プレートが装着されている場合は、取り外します。

3. プレートコンパートメントのカバーとサンプルの蓋を取り外します。

a. 白いプレートコンパートメントカバーの前面にあるノッチを押して、青いスライドドアから取り
外します。

b. プレートコンパートメントカバーを十分手前に引いて取り外します。

サンプルの蓋はプレートコンパートメントのカバー内にあります。

図 6-3 : プレートコンパートメントカバーの一部前方、赤丸のノッチ

図 6-4 : サンプル蓋、上部、およびプレートコンパートメントカバー、下部
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4. 濡れた布またはラボ用ティッシュを使用して、サンプル蓋の底部とプレートコンパートメントカバ
ーをクリーニングします。

5. サンプルの蓋をプレート コンパートメントのカバーに取り付け、蓋とカバーをプレート コンパート
メントのスロットに取り付けます。蓋とカバーをカチッと音がするまで押し込みます。

図 6-5 : プレートコンパートメントのスロット、赤丸で囲った部分

6. ステップ 1 で取り外したプレートを取り付けます。

7. 前面パネルで、Load Sample または Load Reagent をタッチします。

UV フィルターの装着
UV 検出器には、 220 nm と 280 nm の 2 種類のフィルターが付属しています。別のフィルターが
必要な場合は、片方または両方のフィルターを交換できます。次の表を参照：表 7-1。

必要な資材

• フィルター

• パウダーフリー手袋

1. 前面パネルで次を実行します。

a. Direct Control をタッチして、Direct Control ウィンドウを開きます。

b. Wavelength Settings をタッチします。
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図 6-6 : Wavelength Settings ボタン

c. フィルターを交換するには、Replace Filter をタッチします。UV Filter 1 と UV Filter 2 の
値が入力されていない場合、Replace Filter ボタンは使用できません。
タッチスクリーンが更新され、画像と説明が表示されます。

図 6-7 : 光学コンパートメントのアクセスドア

2. システムの左下を押してロックを解除し、光学コンパートメントのアクセスドアを開きます。
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図 6-8 : 光学コンパートメントのアクセスドアを開く

注意: データ損失の可能性。運転中に光学コンパートメントのアクセスドアを開けないでくださ
い。ドアが開くと、電圧システムと光源がオフになり、分離が損なわれる可能性があります。

3. 丸型カバーとフィルターアセンブリを取り外します。

4. つまみねじを反時計方向に回して緩め、フィルターアセンブリを取り外します。
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図 6-9 : UV フィルターアセンブリ

項目 説明

1 UV フィルター 1

2 つまみねじ

3 UV フィルター 2

5. フィルターアセンブリを取り付けます。

6. つまみねじを時計方向に回して締めます。

7. 丸型カバーを取り付けます。

8. 光学コンパートメントのアクセスドアを閉じます。

9. 前面パネルで、Done をタッチします。

10. 前面パネルでフィルター情報を更新します。

a. UV フィルター 1 の UV 波長とシリアル番号を入力します。

b. UV フィルター 2 の UV 波長とシリアル番号を入力します。

c. Done をタッチします。
UV フィルターのデータが正常に変更されました。

メンテナンス

BioPhase 8800 システム BioPhase 8800 Driver for
Empower™システム用
80/107

オペレータガイド
RUO-IDV-05-15014-JA-A



図 6-10 : UV フィルターアセンブリの保存された変更

UV ランプの装着
UV ランプは UV 検出器で使用します。ベースラインのノイズが大きい場合や、ランプが点灯しない
場合は、ランプの交換が必要な可能性があります。

必要な資材

• UV ランプ

• パウダーフリー手袋

警告! 高温面の危険。ランプを交換する前に、十分な時間を取ってランプを完全に冷却させ
ます。高温のランプはやけどの原因となります。

1. 前面パネルで以下を実行します。

a. Direct Control をタッチして Direct Control 画面を開きます。

b. Wavelength Settings をタッチします。
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図 6-11 : Wavelength Settings ボタン

c. UV ランプを交換するには、Replace UV Lamp をタッチします。
ウィンドウが開き、画像と説明が表示されます。

図 6-12 : 光学コンパートメントのアクセスドア

2. 装置の左下を押してロックを解除し、光学コンパートメントのアクセスドアを開きます。
アクセスドアが開くと、安全インターロックによりランプの電源が切れます。
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図 6-13 : UV ランプの交換

項目 説明

1 ランププラグ

2 つまみねじ

3. ランプが冷却するのを待ってから取り外します。

4. コネクタのサイドタブを押して、コネクタをパネルから外します。

5. セルフアップ式つまみねじを緩め、コネクタラッチタブを押します。

6. ランプを取り外します。

7. ピンとノッチを合わせて新しいランプを取り付けます。

8. セルフアップ式つまみねじを締めます。

9. コネクタを取り付けます。

10. 光学コンパートメントのアクセスドアを閉じます。
アクセスドアが閉じると、安全インターロックによりランプの電源がオンになります。

11. 前面パネルで Done をタッチします。
UV ランプが正常に変更されました。
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図 6-14 : UV ランプの変更

12. 必要に応じて、リボンの UV Lamp ボタンをタッチします。
ランプが点灯し、タイマーがカウントダウンして、ランプが使えるようになるまでの時間を示しま
す。

レーザー誘導蛍光検出器フィルターの取り付け
レーザー誘導蛍光検出器には、 488 nm の光を遮断するノッチフィルターと 520 nm の光を透過さ
せるエミッションフィルターの 2 つのフィルターが付属しています。フィルターはフィルターホルダーに
装着して使用します。新しいフィルターが必要な場合は、フィルターホルダーの一式を購入する必要
があります。

必要な資材

• フィルターホルダー（PN 5066941）

• パウダーフリー手袋

1. 前面パネルで以下を実行します。

a. Direct Control をタッチして Direct Control 画面を開きます。

b. Wavelength Settings をタッチします。
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図 6-15 : Wavelength Settings ボタン

c. LIF Wavelength をタッチします。

d. Replace Filter をタッチします。
ウィンドウが開き、画像と説明が表示されます。

図 6-16 : 光学コンパートメントのアクセスドア

2. 装置の左下を押してロックを解除し、光学コンパートメントのアクセスドアを開きます。
アクセスドアが開くと、安全インターロックによりレーザーの電源が切れます。

注意: データ損失の可能性。運転中に光学コンパートメントのアクセスドアを開けないでくださ
い。ドアが開くと、電圧システムと光源がオフになり、分離が損なわれる可能性があります。

メンテナンス

オペレータガイド
RUO-IDV-05-15014-JA-A

BioPhase 8800 システム BioPhase 8800 Driver for
Empower™システム用

85/107



図 6-17 : レーザー誘導蛍光フィルターホルダーの取り外し

3. フィルターとホルダーを取り外します。

4. 新しいフィルターとホルダーを取り付けます。

図 6-18 : レーザー誘導蛍光フィルターホルダー

5. Done をタッチします。
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6. 前面パネルでレーザー誘導蛍光フィルター情報を更新します。

a. レーザー誘導蛍光エミッションフィルターのフィルター波長とシリアル番号を入力します。

b. Done をタッチします。
レーザー誘導蛍光フィルターが正常に変更されました。

図 6-19 : レーザー誘導蛍光波長

ヒューズの交換

警告! 火災または感電の危険。ヒューズを交換する前に、システムの電源を切り、主電
源から切り離してください。交換には、適切な種類および定格のヒューズのみを使用して
ください。これらのガイドラインに従わないと、火災、感電、または装置の不具合を引き起
こす恐れがあります。

必要な資材

• T10A250V と記された 10 A 250 V ヒューズ

• 小型のマイナスドライバー

1. システムの電源を切ります。

2. 主電源ケーブルを主電源コンセントとシステム背面から外します。

3. 小型のマイナスドライバーを使用して、主電源ケーブルのコネクタの上にあるヒューズホルダー
を取り外します。

4. ヒューズキャリアアセンブリからヒューズを取り外します。

5. ヒューズキャリアアセンブリにヒューズを取り付け、その後アセンブリをシステムに取り付けま
す。

6. 主電源ケーブルをシステム背面と主電源コンセントに接続します。

7. システムの電源を入れます。
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8. Windows のデスクトップで BioPhase ソフトウェアを開き、ログオンします。

9. システムが正常に動作しない場合、またはヒューズが再び切れた場合は、sciex.com/request-
support に連絡してください。
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部品の注文 7
• SCIEX への部品の注文は、以下のいずれかの方法で行ってください。：

• 電話: (877) 740-2129、オプション 1 (フリーダイヤル、米国のみ)、または sciex.com/
contact-us にアクセスし、ローカルオフィスを確認してください。

• 電子メール： Sales.Americas@sciex.com

• FAX: (800) 343-1346

• インターネット：米国、英国、ドイツにお住いのお客様は、store.sciex.com からご注文くださ
い。

カートリッジと部品

部品番号 説明

359976 キャピラリーカートリッジクーラント、450 mL

5080311 BioPhase 化学プレートキット（サンプルプレート× 4、試薬プレート×
4、アウトレットプレート× 8）

5080313 BioPhase サンプルプレート（20 プレート）

5080314 BioPhase 試薬プレート（20 プレート）

5080315 BioPhase アウトレットプレート（20 プレート）

5080121 カートリッジ、キャピラリー× 8、長さ 30 cm、外径 360 µm、内径 50
µm、ベアフューズドシリカキャピラリー

5.080.119 カートリッジ、キャピラリー× 8、長さ 30 cm、外径 360 µm、ニュート
ラルキャピラリー

表 7-1 : フィルター

部品番号 説明

5085153 220 nm と 280 nm のフィルターを使用した UV フィルターアセンブ
リ

5066890 UV フィルター、220 nm

5072643 UV フィルター、280 nm

5085159 520 nm のフィルターを使用したレーザー誘導蛍光フィルターホルダ
ー

5085178 560 nm のフィルターを使用したレーザー誘導蛍光フィルターホルダ
ー
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表 7-1 : フィルター (続き)

部品番号 説明

5085177 600 nm のフィルターを使用したレーザー誘導蛍光フィルターホルダ
ー

表 7-2 : ランプ

部品番号 説明

5065163 重水素ランプ

部品の注文
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システム仕様 A

装置の仕様

寸法（H × W × D） 72 cm x 62 cm x 69 cm（28.2 インチ× 24.4 インチ× 27.2 インチ）

重量 90.9 kg（200 ポンド）

電気 必要電力：100 VAC ～ 240 VAC、10 A、50 Hz または 60 Hz、クラ
ス I

消費電力：電源電圧は公称値を 10％ 超えないこと

ヒューズ：

• T10 A

• 250 V

設置（過電圧）カテゴリ：カテゴリ II

作業環境 高度：海抜  2,000 m （6,562 フィート）

湿度：30 °C で < 70%（結露なし）

温度：15 °C ～ 30 °C （59 °F ～ 86 °F）を推奨

最大放熱量 定常状態で 600 W（2,047 BTU/ 時）

最大音圧 70 dB

最大音圧（1 m）：66 dB

検出器の仕様

UV 検出器の仕様

表 A-1 : UV 検出器の仕様

利用可能なフィルター 220 nm と 280 nm

フィルター帯域幅 25 nm 公称

UV 光源 33 W 調整済み重水素ランプ

UV 光源の寿命 1,000 時間
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（オプション）レーザー誘導蛍光検出器の仕様

表 A-2 : レーザー誘導蛍光検出器の仕様

ベースラインドリフト < 0.2 RFU/hr

ベースラインのノイズ < 0.005 RFU ピークツーピーク

ダイナミックレンジ（設定値
1,000 の場合）

> 104

デフォルトのフィルター 488 nm ノッチフィルター（励起波長遮断用）、520 nm バンドパスフィ
ルター

レーザー 3 mW, 488 nm ソリッドステート

レーザーの寿命 10,000 時間

RFU の範囲 0 RFU ～ 1,000 RFU

感度 1 × 1011 M フルオレセインナトリウム、シグナル対ノイズ比 > 2

光学系波長範囲 励起：488 nm

検出：500 nm ～ 750 nm（フィルターによる）

プレートの仕様
このセクションでは、サンプル、試薬、アウトレットプレートで動作するように液体処理システムを構
成する方法について説明します。

サンプルプレートの仕様

サンプルプレートを使用して液体処理システムを構成する場合は、以下の図の寸法を使用してくだ
さい。サンプルプレートは、ANSI Society for Laboratory Automation and Screening (SLAS) の
規格に準拠しています。
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図 A-1 : サンプルプレートの寸法

寸法 値

左端からウェル A1 の中
央まで

14.38 mm

上端からウェル A1 の中
央まで

11.24 mm

底面の長さ 127.76 mm

底面の幅 85.48 mm
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図 A-2 : サンプルプレートウェル断面図寸法

寸法 値

ウェルの深さ 22.10 mm

ウェルの開口部のサイズ 5.00 mm

ウェル間のピッチ 9.00 mm

図 A-3 : サンプルプレート側面の寸法

寸法 値

全高 31.25 mm

試薬プレートの仕様

試薬プレートを使用して液体処理システムを構成する場合は、以下の図の寸法を使用してくださ
い。

システム仕様
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図 A-4 : 試薬プレートの寸法

寸法 値

左端からウェル A1 の中
央まで

14.38 mm

上端からウェル A1 の中
央まで

11.24 mm

底面の長さ 127.76 mm

底面の幅 85.48 mm

図 A-5 : 試薬プレートウェル断面図寸法
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寸法 値

ウェルの深さ 29.95 mm

ウェルの開口部のサイズ 5.00 × 8.27 mm

ウェル間のピッチ 9.00 mm

図 A-6 : 試薬プレート側面の寸法

寸法 値

全高 31.25 mm

アウトレットプレートの仕様

アウトレットプレートを使用して液体処理システムを構成する場合は、以下の図の寸法を使用してく
ださい。
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図 A-7 : アウトレットプレートの寸法

寸法 値

左端からカラム 1 の中央
まで

14.38 mm

ウェルの上端から上端ま
で

7.11 mm

底面の長さ 127.76 mm

底面の幅 70.00 mm
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図 A-8 : アウトレットプレートウェルの断面および側面の寸法

寸法 値

ウェルの深さ 29.95 mm

ウェルの開口部のサイズ 5.00 × 55.79 mm

ウェル間のピッチ 9.00 mm

図 A-9 : アウトレットプレート側面の寸法

寸法 値

全高 31.25 mm
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シンボルについての用語集 B
注: 以下の表のすべてのシンボルが、すべての機器に適用されるものではありません。

シンボル 説明

オーストラリアの監督法規の遵守マーク。本製品が、Australian
Communications Media Authority（ACMA）の EMC 要件を満たし
ていることを表します。

交流

A アンペア（電流）

窒息の危険

ヨーロッパ共同体の公認代表者

生物学的危険

CE 適合マーキング

cCSAus マーク。カナダおよび米国での電気安全認証を示します。

カタログ番号

注意。起こりうる危険についての情報は、説明書を参照してくださ
い。

注: SCIEX マニュアルでは、このシンボルは人身傷害の危険を示し
ます。

シンボルについての用語集
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シンボル 説明

  

中国 RoHS 注意ラベル。電子情報製品は特定の毒性または有害
物質を含んでいます。中央に書かれている数字は、環境保護使用
期限（EFUP）の日付であり、製品の操作可能暦年を数字で示すも
のです。EFUP の期限が切れた際は、製品は速やかにリサイクルさ
れなければなりません。回転矢印は、製品がリサイクル可能である
ことを示します。ラベルまたは製品にある日付コードは、製造年月日
を示します。

中国 RoHS ロゴ。装置は最大濃度値を超える毒性および有害物質
または元素を含んでおらず、リサイクルおよびリユース可能な環境
に優しい製品です。

使用説明書を参照してください。

圧砕の危険

TUV Rheinland of North America 用の cTUVus マーク

ユニークデバイス識別子（UDI）を取得するためにバーコードリーダ
ーでスキャンできる Data Matrix シンボル

環境の危険

イーサネット接続

爆発の危険

眼球傷害の危険

火災の危険

シンボルについての用語集
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シンボル 説明

可燃性化学物質の危険

壊れ物

ヒューズ

Hz ヘルツ

内部安全シンボル「注意－感電の危険あり」（ISO 3864）、別名高
電圧シンボル
メインカバーを取り外す必要がある場合は、感電を避けるために
SCIEX の代理店に連絡してください。

高温面の危険

実験室用診断機器

イオン化放射の危険

濡らさないでください。

雨にさらさないでください。

相対湿度は 99%以下でなければなりません。

上部を上にしてください。

引き裂き/切断の危険

レーザー放射線障害の危険

シンボルについての用語集
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シンボル 説明

吊り上げ時の危険

磁気の危険

メーカー

可動部品の危険

ペースメーカーの危険。ペースメーカーを使用している人はアクセス
できません。

挟み込みの危険

加圧ガスの危険

保護接地（アース）

穿刺災害の危険

反応性化学物質の危険

シリアル番号

有害化学物質の危険

シンボルについての用語集
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シンボル 説明

システムの輸送および保管は 66 kPa ～ 103 kPa 以内で行ってく
ださい。

システムの輸送および保管は 75 kPa ～ 101 kPa 以内で行ってく
ださい。

システムの輸送および保管は指定された相対湿度の最小（min）お
よび最大（max）レベルの間で、結露が発生しない状態で行ってくだ
さい。

システムの輸送および保管は–30 °C ～ +45 °C 以内で行ってくだ
さい。

システムの輸送および保管は–30 °C ～ +60 °C 以内で行ってくだ
さい。

USB 2.0 接続

USB 3.0 接続

紫外線放射の危険

英国適合性評価マーク

VA ボルトアンペア（皮相電力）

V ボルト（電圧）

WEEE.分別されていない一般廃棄物として機器を廃棄しないでくだ
さい。環境の危険

W ワット（電力）

シンボルについての用語集
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シンボル 説明

yyyy-mm-dd

製造年月日

シンボルについての用語集
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警告についての用語集 C
注: コンポーネントの識別に使用されるラベルのいずれかが剥がれた場合は、フィールドサービスエ
ンジニア（FSE）にお問い合わせください。

ラベル 翻訳（該当する場合）

EN61326—1, EN61326—2-6, CLASS A,
GROUP 1, ISM EQUIPMENT

EN61326—1、EN61326—2-6、クラス A、グル
ープ 1、ISM 機器

FCC Compliance. This device complies with
Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1)
this device may not cause harmful
interference, and (2) this device must accept
any interference received, including
interference that may cause undesired
operation.

FCC 準拠。この装置は、FCC 規制のパート 15
に準拠しています。操作は以下の 2 つの条件を
満たす必要があります。（1）この装置は有害な
混信を発生させることがない、および（2）この装
置は望ましくない操作を引き起こす可能性があ
る混信を含むいかなる受信した混信も受け入れ
なければならない。

FOR RESEARCH USE ONLY. NOT FOR
USE IN DIAGNOSTIC PROCEDURES.

研究専用。診断手段としての使用は想定されて
いません。

WARNING: Lifting Hazard.

FOUR PERSONS REQUIRED TO LIFT
THIS EQUIPMENT.

警告：持ち上げ操作の危険

この装置を持ち上げるには 4 人が必要です。

WARNING: NO USER SERVICEABLE
PARTS INSIDE. REFER SERVICING TO
QUALIFIED PERSONNEL.

警告：ユーザーは内部部品の修理を行わない
でください。修理が必要な場合は、資格のある
サービス担当者にお問い合わせください。

注: 使用説明書を参照してください。

WARNING: CANCER AND
REPRODUCTIVE HARM.

www.P65Warnings.ca.gov

警告：癌および生殖器への障害。

www.P65Warnings.ca.gov

警告についての用語集
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お問い合わせ先

お客様のトレーニング
• 北米：NA.CustomerTraining@sciex.com

• ヨーロッパ：Europe.CustomerTraining@sciex.com

• ヨーロッパおよび北米以外：sciex.com/education

オンライン学習センター
• SCIEX Now Learning Hub

消耗品と試薬の購入
SCIEX の消耗品と試薬は store.sciex.com からオンラインでご注文いただけます。ご注文の場合
は見積書、注文確認書、または発送書類に記載されているアカウント番号をお使いください。現在
は、米国、英国、ドイツのお客様がオンラインストアにアクセスできますが、今後、他の国にもアクセ
スを拡大する予定です。米国、英国、ドイツ以外のお客様は、地域の SCIEX サービス担当者まで
ご連絡ください。

SCIEX サポート
SCIEX およびその代理店は、十分に訓練を受けた保守/技術専門要員を世界中に配置していま
す。システムまたは起こり得る技術的問題に関するご質問にお答えします。詳細な情報について
は、SCIEX web サイト (sciex.com) を参照するか、以下の連絡先までお問い合わせください。

• sciex.com/contact-us

• sciex.com/request-support

サイバーセキュリティ
SCIEX 製品のサイバーセキュリティに関する最新のガイダンスについては、sciex.com/
productsecurity を参照してください。

説明書
このバージョンのドキュメントは、以前のすべてのバージョンのドキュメントに優先します。

このドキュメントを電子的に閲覧するには Adobe Acrobat Reader が必要です。最新バージョンを
ダウンロードするには、https://get.adobe.com/reader にアクセスしてください。

ソフトウェア製品の説明書については、ソフトウェアに付属のリリースノートまたはソフトウェアインス
トールガイドを参照してください。

お問い合わせ先
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ハードウェア製品のマニュアルについては、システムまたはコンポーネントに付属の説明書を参照し
てください。

ドキュメントの最新版は SCIEX の web サイト（sciex.com/customer-documents）で入手できま
す。

注: このドキュメントの無料の印刷版を請求するには、sciex.com/contact-us までお問い合わせくだ
さい。

お問い合わせ先
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